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Note

Trademarks

Revisions

5th Edition: May 2007 (YK)

Thank you for purchasing the CX2000. This operation guide briefly explains the main
operations related to the loop control function of the CX2000. For information about all
the functions excluding the communication functions, installation and wiring procedures,
operating procedures, and handling precautions of the CX2000, see the electronic
manual CX2000 User’s Manual (IM 04L31A01-01E) provided on the accompanying CD-
ROM. The following five manuals are provided in addition to this manual and the CX2000
User’s Manual. Read them along with this manual.

Electronic Manuals Provided on the Accompanying CD-ROM

Manual Title Manual No. Description

CX1000/CX2000 IM 04L31A01-17E  Describes the communication functions of the
Communication Interface CX1000/CX2000 using the Ethernet/serial
User’s Manual interface.

DAQSTANDARD for IM 04L31A01-61E  Describes the functions and operating procedure
CX User’s Manual of the software “DAQSTANDARD for CX” that

comes with the package.

Paper Manuals

Manual Title Manual No. Description

CX2000 Installation and IM 04L31A01-71E  Describes concisely the installation procedures
Connection Guide and wiring procedures of the CX2000.
Precautions on the Use IM 04L31A01-72E  Precautions regarding the use of the CX1000/
of the CX1000/CX2000 CX2000.

Control of Pollution Caused IM 04L31A01-91C  Gives a description of pollution control.
by the CX1000/CX2000

+ This manual provides information on the CX2000, style number “S3.”

+ The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions.

« Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

« Copying or reproducing all or any part of the contents of this manual without
Yokogawa’s permission is strictly prohibited.

+ The TCP/IP software of this product and the document concerning the TCP/IP software
have been developed/created by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the Regents of the University of California.

+ vigilantplant, DAQSTATION, and Dagstation are registered trademarks of Yokogawa
Electric Corporation.

+ Microsoft and Windows are registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

+ Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems
Incorporated.

+  Company and product names that appear in this manual are registered trademarks or
trademarks of their respective holders.

+ The company and product names used in this manual are not accompanied by the
registered trademark or trademark symbols (® and TM).

1st Edition February, 2002 4th Edition June, 2003
2nd Edition April, 2002 5th Edition May, 2007
3rd Edition January, 2003

All Rights Reserved, Copyright © 2002 Yokogawa Electric Corporation
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Introduction to Control Functions

For further details on each function, see chapter 1, “Explanation of Functions” in the

CX2000 User’s Manual (IM 04L31A01-01E) provided on the accompanying CD-ROM.
Control Types

Control Mode

The following four control modes are available (three types of control plus analog

retransmission) and can be set for each control loop. The mode can be specified for

each control output terminal block (two loops per block, see page 7). However, single

loop control can be specified on the control output terminal block for loops 5 and 6.

Single-loop control Cascade control Loop control with PV switching Analog retransmission
PV1 PV2

ind PV1 PV2 Output comes from

the control output
sP— PD | SP J sP— PID | channels per the

results of the

ouT | PID | ouT specified equation.

l PV: Process value
ouT SP: Target setpoint

OUT: Control output
Control Operation Mode

You can specify either of the following control operation modes for each control loop.
However, program control operation can be specified only on models with the program
control option.

+ Fixed-point control (program control OFF): Set the SP locally or use remote input

+  Program control operation: Set the SP locally or use program patterns

PID Control Function
Control Computation Types and Control Output Format
You can select from time proportional PID control (voltage pulse/relay output),
continuous PID control (current output), or On/Off control (relay output).
Control Direction
You can select the direction in which OUT changes according to the polarity of the
deviation between the SP and the PV.
+ Reverse action (PV > SP: OUT decreases, PV < SP: control output increases)
+ Direct action (PV > SP: OUT increases, PV < SP: control output decreases)
PID Control Mode
You can select the change in the operation when the SP is changed.
+ Follow-up: Controlled so that the output reaches the new SP quickly
+ Fixed-point: Suppresses sensitive reaction of the output to change to the new SP
PID Control Method
One of the following methods is automatically selected depending on the PID control
mode and the control operation mode.

+ PV derivative type: Control method in which the control output is kept from
changing radically when the SP is changed by a great
amount

+ Deviation derivative type: Control method in which fast response to follow the SP is
emphasized

Control Parameter (“PID Parameter” in the Settings)

You can set up to eight groups of control parameter sets for each loop. Control
parameters include SP, PID constant, control output limiter, manual reset value, control
direction, and preset output.
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Introduction to Control Functions

PID Parameter Selection Method

You can select the method for switching PID parameters from the following:

+ Target setpoint selection: By specifying the SP number.

« Zone PID selection: By dividing the measurement span in to multiple zones and
determining in which zone the PV resides.

+ Segment PID selection:  Using the program pattern segment when in program
control.

Tuning

There are two methods: auto tuning of PID constants using the limit cycle method, and

manual tuning that allows PID parameters to be set individually during operation.

Control Suppression Function

Anti-Reset Windup (Over-Integration Prevention)

Overshoot may occur if the deviation between the SP and PV continues for an extended
time and the control output reaches the output high-limit through the integration process.
To prevent this from happening, the anti-reset windup function is used to pause the
integration process when the manipulated output reaches the high limit of the output
limiter.

N Stop PID Start PID
100% computation computation

Output |----—- N
high limit Output
value

- Time

- Time

Overshoot Suppression Function (“Control Output Suppression” in the Settings)
The deviation is monitored to detect the danger of overshooting and automatically
changes the SP to a slightly lower tentative value referred to as the “auxiliary target
setpoint” and continues control. Then, when the process value enters a range in which
overshooting is no longer a danger, the auxiliary target setpoint is gradually returned to
the original SP.

PV Auxiliary SP

Original SP N / ’

Time

Control output Start fuzzy logic
suppression function On

Control Output Limiter

You can set high and low limits of the control output range (“output high-limit/low-limit” in
the settings) regardless of the operation mode.

Shutdown

This function is used to close the control value fully (set the output to 0) exceeding the
dead band of the control valve positioner.

Output Velocity Limiter

This function is used to prevent radical changes in the control output to protect the
control element and object of control.

IM 04L31A01-02E



Introduction to Control Functions

Preset Output

This function sets the control output to the preset value when the operation is stopped.
SP Ramp-Down-Rate/SP Ramp-Up-Rate

This function is used to decrease or increase the setpoint at a constant rate of change
(as opposed to a rapid change) when the SP is changed.

Target Setpoint Limit

This function is used to limit the range of values that the SP can change.

Tracking Function

You can set the following two tracking functions to suppress a radical change in the

output.

SP tracking: When switching from remote to local operation mode, the output is tracked
to the remote SP immediately before the SP switching.

PV tracking: The SP is matched to the PV at that point and then returned to the original
value according to the target setpoint ramp-up rate or the target setpoint
ramp-down rate.

Control Alarm Function
You can set up to four alarms for each loop. The following alarm types can be specified.
PV upper-limit alarm, PV lower-limit alarm, deviation high limit alarm, deviation low limit
alarm, deviation high/low limit alarm, deviation high and low limits alarm, SP high limit
alarm, SP low limit alarm, output high limit alarm, and output low limit alarm.

6 IM 04L31A01-02E



Input/Output terminals are arranged on the rear panel of the CX2000 as shown in the
figure below. The figure shows the case when option terminals are specified on the
model with 6 internal control loops and 20 measurement channels (CX2620). For the
wiring procedure of the control/measurement input/output, see chapter 2, “Installation
and Wiring” in the CX2000 User’s Manual (IM 04L31A01-01E) or the CX2000 Installation
and Connection Guide (IM 04L31A01-71E). For a description on the connection of
communication interfaces such as the serial or Ethernet interface, see the CX2000
Communication Interface User’s Manual (IM 04L31A01-17E).

« Universal control output: for 2 loops

Select current, voltage pulse, or
relay output
« Control contact input: 6 inputs
« Control contact output
Relay output: 2 outputs
Transistor output: 2 outputs

PC

T
; — 100V to 240 VAC/

24 VDC/AC (/P1 option)
o 0

Controlling element

CX2000

Magnet
switch

ontrol output
terminal block
Loops 1 and

s

| Contact Contact
iinpul output
16 inputs 6 outputs

[
il
ool

Magnet
switch

i

PLC
(such as the FA-M3
by Yokogawa)

Serial interface port

ontrol output
¥ terminal block

Analog control
input terminal block

Loops 3 and 4y

O

| Contact Contact
iinpul output
16 inputs 6 outputs
1

e

| Contact Contact

Jinput  output
i6 inputs 6 outputs
Mea: nt al itput .

Measurement a!arm ?::::: in::vr::l:;f Lt Control DIO expansion

output (/A6 option) (/AGR option) (/CST1 option)
Measurement alarm output + Measurement alarm output + Four 24-VDC transmitter

FAIL/memory end output FAIL/memory end output + power supplies

(/A4F option) remote input/output (/A6R option) (/TPS4 option)

Terminal Arrangement of the Analog Input Terminal Block for 6 Loop Control
(Conceptual Diagram. When PV/SP computation is OFF)

The following figure denotes the three terminals (/b, +/A, -/B) of a single column using a
single cell.

PV, PV1, PV2: measurement input, (RSP): remote input
(not used during program control), (J: unused terminal

5 LOOP41 LO?PG 5 L00P31 5 LO(’JP21 L010P5 5 L00P11 [Control mode setting]
(RSP) | PV PV_|(RSP) | PV | (RSP) | PV PV_[ (RSP) [ PV | «<During single-loop control
l [pv T OJwp[p [ O Jpv [ O[@RSP]PY |« During cascade control
[Pv2 [pvi [ O [pv2a [Pt [ P2 [Pvi [ O [P2] PV |<Duringloop control with

PV switching
Terminal Arrangement of Loop 1 and 2 Control Output Terminal Block(When PV/

SP computation is OFF)

Control relay Control current/  Transistor

Rela:
v voltage pulse

contact output contact output output out;‘)ut Contact input
|

[ ‘ DIGITAL OUT JJIGITAL OLJT DIGITAL IN

O O 2 LOOP2| LOOP1 o
(5] (3] (1]

0o o PULS] | [PULS]||[6 ] [ 4 J||[ 5 ] [2]
o o 0 1 0 (cfftcT (6] [3]

CTRL OUT CTRL OUT
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Overview of Operations

Key Operation
For details on the key operation, see chapter 3, “Names of Parts, Display Modes, and
Common Operations” in the CX2000 User’s Manual (IM 04L31A01-01E).

Select the value or execute the operation
that is displayed in soft key menu

L L
[ e 6O
Start/Stop data @ —— Confirm the value
acquisition to — or operation
the internal @
memotry and L ¥
waveform display Select parameters or move the cursor
Cancel an operation Enter characters or numbers
Execute the assigned Switch between operation mode and setting mode
action

Switch from setting mode to
basic setting mode or display
possible functions in operation
mode in the soft key menu

Switching Operation Modes

There are four operation modes: operation mode, control setting mode, common and

measurement setting mode, and basic setting mode.
Power ON Display Transition Diagram
' Operation mode

End soft key -> DISP/ENTER key
(This operation saves the settings made in the
basic setting mode.)

Operation display
2 Cannot switch to the
MENU Key or ESC ke basic setting mode
4 Y| common and during data
MENU key ESC key measurement acquisition,
Control setting mode setting mode zgnmtf;taot;:?a’t?;n Basic setting
[Setting mode (Control)] [Set mode] ) mode
i
MENU key Press the FUNC
key for 3 s2
Menu Press the FUNC Menu Menu
key for 3 s2
Soft keys T '\En:gll‘('el;ey or Soft keys l T 'é"sEg zekey or Soft keys l T ESC key
Y
Setup displays Setup displays Setup display
(#1 to #81) (#1 to #8) (#1 to #103)
1#1 to #9 when program 3 #1 to #9: Basic common and
control is ON. measurement settings

#10: Basic control settings

Switching Displays during Operation Mode
You can change the operation display according to your needs by carrying out the

following procedures.
; ==
Operation v
|

display E—— B
Sub menu

:

|
T Display selection menu

indicates the DISP/ENTER key. A v » indicates arrow keys.
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Overview of Operations

Control Operation Display
In operation mode, the following control operation displays can be selected.
+ Control group display
This display is used to monitor the control status of multiple loops simultaneously
including external loops. You can select from three display styles as shown in the
display example in the figure below. If you include the measurement channels for the
measurement function in the group, you can also monitor the measured values on
the measurement channels at the same time on this display.
+ Tuning display
This display is used to optimize (tune) the control parameters such as PID constants.
+  Overview display
This display is used to monitor the alarm status of all control loops.
+ DI/DO status display
Displays the ON/OFF status of the current contact input (DI) and contact output (DO).
+ Control action summary display
Displays a log of control actions such as operation run/stop and auto/manual
operation switching.
+ Internal switch status display
Displays the ON/OFF status of the internal switch.
On models with the program control function option, the following additional displays are
available: 1) the program operation status display, which can show the pattern and
current PV accumulated on the screen during program operation and 2) the program
event summary display, which shows a log of time events and PV events that occurred
during program operation.
Displays common with the measurement function include: 1) the alarm summary display,
which shows a log of alarm occurrence status and 2) the memory summary display,
which shows the file information of the internal memory.
In addition, on the trend display of the control function, the PV, SP, OUT can be assigned to
virtual channels (control channels), and the trend of control status can be displayed like the trend

waveforms of measurement channels on the trend display of the measurement function.
. Display E pl
+ Control group display ISprdy =xamples

i aew G e - e o DR S
0oPa1 INLooPR2
= Al

i D ter 018 (5] B 0 )

M.

Lo® | an | s o | | P | B EE_
Controller style Faceplate style Hybrid style
» Tuning display » Overview display - DI/DO status display

Sl g @ ur | - o O

[f
|
&

» Trend display

ey 5o [ U N e B &
T -

HEbY

235IREILEREEE3aaga

HEYEEYYE
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Overview of Operations

List of Control Setup Items

Basic Control Setup Items in Basic Setting Mode
#1 Control action, Input setting
PID number, control period, zone PID, restart mode, restart mode (program) (only on
models with the program control option), initial PID, 6/4 loop select (only on models
with six loops), auto tuning, control mode, method (only during loop control with PV
switching), program control ON/OFF (only on models with the program control
option), PID control mode, burnout, and RJC.
#2 DI/DO/SW registration, AUX (Alarm mode)
Contact input registration, remote setting, alarm mode, SP number selection source,
PV/SP math, CLOG error, and event output setting.
#3 Output processing
Control output, cycle time, and analog-output type
#4 Relay
FAIL ON/OFF, self diagnosis ON/OFF, and relay action/behavior (energize/
deenergize, hold/nonhold)
#5 Tuning setting
Tuning item selection
#6 External loop setting (For details on the settings, see the CX71000/CX2000
Communication Interface User's Manual (IM 04L31A01-17E).)
Setup Items in the Control Setting Mode
#1 Control input range
Input type, mode, type, range, span, scale, unit, square root, low-cut, bias, filter, and ratio.
#2 Control alarm
Type, standby, relay output ON/OFF, and alarm value
#3 Operation-related parameters/Zone PID
Suppressing function, ramp-rate-time unit, SP ramp-down-rate/SP ramp-up-rate, tag,
tag comment, reference point (when zone PID is selected), switching hysteresis
(when zone PID is selected), and reference deviation (when zone PID is selected).
#4 PID parameters
SP, PID constant, output limit, shutdown ON/OFF, manual reset, relay hysteresis
(only during ON/OFF control), reverse/direct, and preset output.
#5 Control group setting
Group name, kind (internal loop/external loop/measurement channel), and number.
#6 Ten-segment linearizer 1/0
Input type, mode, and biasing or approximation input/output values.
#7 Program control (only when program control is ON)
#1 Program parameter setting
Pattern initial setting, wait action setting, pattern start setting, program pattern
setting, event setting, hysteresis (PV event), and repeat action setting.
#2 Event output setting
#3 AUX (auto message, display position)
#4 AUX (event group)
#8 Detailed setting (When program control is OFF, Detail setting is #7)
#1 Control function
SP tracking, PV tracking, SP limiter, output velocity limiter, and anti-reset windup
auto/manual.
#2 Hysteresis (Alarm)
#3 DIO monitor and operation setting
#4 DI/DO label setting
#9 Control math setting (When program control is OFF, Control math setting is #8)
#1 PV/SP math, Retransmission
#2Logic math (#1 when both PV/SP computation and analog retransmission are
inactive.)
#3 Constant (#2 when both PV/SP computation and analog retransmission are
inactive.)
Constant used in computations for control

10
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Examples of Control Setup Operation

Control Setup Example 1: Single Loop Control
Object of Control and Description
CX2000

PV

TC | LOOP1 PV!

Alarm output
DIGITAL OUT13

—>‘\— High limit temperature alarm

DIGITAL OUT2®
_>‘ Low limit temperature alarm

TLoop 1 PV input terminal

LOOP1 PULS? of the control input terminal block

2 Loop 1 voltage pulse output terminal
of the control output terminal block

control output 3 Relay contact output terminal

of the control output terminal block

Electric
furnace
SSR l Voltage-pulse
| I
©

+ Loop number: 1
» PID constant: P=5%,1=240s,D=60s
» Control direction: Reverse
+ Input type: TC K type

+ Measurement span: 0 to 1200°C
+ Output type:
+ Temperature setpoint: 700°C
« Alarm output:

limit: 600°C)

Basic Control Settings
1. From the operation display, open the basic control setting menu according to the
following procedure.

Voltage pulse (cycle time: 3 s)

PV high-limit alarm (high limit: 800°C), PV low-limit alarm (low

Press the MENU key (to switch to Set mode), then hold down the FUNC key for 3 s
(to switch to basic setting mode). Press the Next 1/2 soft key, then the #10 soft key

(to select Control).
Menu (Setting mode (Control))

Setting node{Control)

Control input range
B control alarn

Operation-related paraneters/Zone PID
T Fio rarameters

Control srow setting

Ten-segnent |inearizer 170

ITETION [ BT ] Detai led (DID noniter and operation.etc...)
[8 ] Control nath setting

|| | hext 172

Menu (Basic setting mode 2/2)

Basic setting node

B coomnication
B e E-rui)
A Tine zone
T contro!
ET e

| Nt i w0 [ Kew login
B ey [
B heleck [ B | ootien

[ n o BN o e et 22 |

Menu (Basic setting mode 1/2)

Basic setting mde

T éarm. A0, Tomeraturs:

I reccr.Neaory and trend.tescry tines
Koy lock

— | u I

PN Load. Initialize...
Ootion

[T ) conmnication 918 Control
8] b E-ai £
=

/ Menu (Basic control setup menu)

Satup Hode

Control
Contral action.Imeut setting
DL/D0/N-registration. AK(A arn node... )
Dutput processing
Relmy
Tuning setting

IS External lowe setting

zaEnn=

IM 04L31A01-02E
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Examples of Control Setup Operation

2. Press the #1 soft key (Control action, Input setting).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and then press the DISP/ENTER

key.
Setup Node G
Control{Control action,Input setting)
rControl action Mnput settine—————
PID number 8 Loop number 1
Control period 250ns
Zone PID [ off Burnout -
Restart mode Continue Heasurel Up
Heasure2 Up
Initial PID Tenp Renote Up Select Temp
E/4Toop select 61loop RJC initi — B9
e o Heasurel Trternal (Set initial PID to P = 5%,
1=240s,and D =60 s)
Loop nunber 1 Heasura2—[Tnternal— Select 1
Control node | Single ! Renot Frternat Select Single
(single loop)
PID control mode | FolTow-up

0ff Single | Cascade |PYSwitch

4. Press the ESC key to return to the basic control setting menu.

5. Press the #3 soft key (Output processing).

6. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and then press the DISP/ENTER
key.

To set Cycle time, press the Input soft key to open a numeric entry pop-up window
as shown in the figure below. Enter the value using the Character/Number key and
the Space soft key and then press the DISP/ENTER key.

=t

Setup Hode

Control(Qutput processing)
utput processing

Loop number [ 1 Select 1
Select Voltage-pulse

Control output
Cycle time

fnalog-output type Setto3s

1.Use horizontal arrow key .
to 9|{|:anse the cursor Numeric entry pop-up
position. N

2.Use DISP/ENTER key to window
define the input parameter.

3.Use ESC key to cancel the
input parameter.

* No need to set
Analog-output type

7. Press the ESC key twice to return to the menu display (basic setting mode 2/2).
8. Press the End soft key.
A confirmation window shown below opens.

Do you want to store and make
the new settings take effect?

Com M No  MCancel

9. Press the DISP/ENTER key to confirm the settings.
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Examples of Control Setup Operation

Setting node{Control)

TR control imout ranoe
B control alarn

Operation-related paraneters/Zone PID

T Fio rarameters

Contral srowm setting

Ten-sement |inearizer 10

Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu
shown below.

GROP |
3

JTETION (KT Detai led (DID nonitor and operation.etc...)

B | Control nath setting

0 I |

et 172

2. Press the #1 soft key (Control input range).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value, and press the DISP/ENTER key.
To set the measurement span (span lower/upper-limit, press the Input soft key to

open a numeric entry pop-up window as shown in the figure below. Enter the value

using the Character/Number key and the Space soft key and then press the DISP/

ENTER key.

GROLP 1 =)
Oct.B5.2082 19:45:34 ‘Aee DISP

Control input range

. hor @

rInput range

Loop mumber [T Control mods - Singls loop contral }

Select 1
Select PV1

Input type PV1

Hode TC
Range [ K -
Span

Lower-Timit 8.0
Upper-Timit 1370.8

Square root off

4. Press the DISP/ENTER key.

Rvai lable range
-288.0/ 1378.8

position.
2.lUse DISP/ENTER key to
define the input parameter.

3.Use ESC key to cancel the
input parameter.

A confirmation window shown below opens.

&) Do vou really want to change the settings?

veso| TN

5. Press the DISP/ENTER key to confirm the settings.

Select TC

Select K

Set to 0.0
Set to 1200.0

Numeric entry pop-up

window

IM 04L31A01-02E
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Examples of Control Setup Operation

Setting Control Alarms in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #2 soft key (Control alarm).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric value of the alarm is entered using the pop-up window that appears by
pressing the Input soft key.

Select PV-High

Select On Select On
Select DO001
Select 1 | Select PV-Low Select DO002
|.l ; pa: 19:48:4 R P i I:’
[ Alarn
Loop ni bber 1
T Standb Ee% ; N fActi
e an utpu umber]  Action
1 n I_EP_ PV-High Off On D0BR]  Energize
2 n_ | PY-Low [ off [ On" [ DOBE2 Energize
3 [off_
4 | Off
SP number 1 Select 1
Al ]
1 [ Eas— Set to 800.0
2 600. 0 Set to 600.0
3 [1288.8
4 1268.8

4. Press the DISP/ENTER key to confirm the settings.

Setting PID Parameters in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #4 soft key (PID parameters).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numerical values such as the SP are entered using the pop-up window that
appears by pressing the Input soft key.

Select 1

_—— Select 1
| — Setto 700.0

|| — Select Reverse

GROUP 1 =]
Oct. 5. 2082 195104 e 01" NN 1hour @ *)
PID parameters
r  PID parameters
Loop number | 1
PID number [1-
Target setpoint TE0.8 — Reverse/Direct [Reverse -

Proportional band(P} [IENIN-

Integral time{I} 248 85—
Derivative time{D) [{1]

Output lower limit
Output upper linit

Hanual reset

[ 88 %
[1ee-8 %

[50.8 %

= Keep the initial PID
values for Temp

4. Press the DISP/ENTER key to confirm the settings.

14
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Examples of Control Setup Operation

Control Setup Example 2: Cascade Control
Object of Control and Description

CX2000 Alarm output
7)) DIGITAL OUT1*

—»‘\— High limit temperature alarm
DIGITAL OUT2*

—V. Low limit temperature alarm
DIGITAL OUT3*

—»‘— High limit steam pressure alarm

J LOOP2 PV | LOOP2 mA? "Loop 1 PV input terminal

Primary PV input
>

LOOP1 PV!

PV input

Pressure
transmitter

current output 2 Loop 2 PV input terminal

3 Loop 2 current output terminal

Steam 4 Relay contact output terminal

Primary loop of cascade control

Loop number: 1

PID constant: P=20%,1=300s,D=60s
Control direction: Reverse

Input type: RTD Pt100

Measurement span: 0to 100°C
Temperature setpoint: 80°C

Alarm output: PV high-limit alarm (high limit: 90°C), PV low-limit alarm (low
limit: 70°C)
Secondary loop of cascade control
Loop number: 2
PID constant: P=120%,1=20s,D=0s
Control direction: Reverse
Input type: 1-5V
Measurement span: 0 to 1.00 MPa
Output type: Current output (4-20 mA)
Alarm output: PV high-limit alarm (high limit: 0.90 MPa)

Basic Control Settings
1. Display the basic control setting menu.

See “Control Setup Example 1” for the steps to show the menu.

Setup fode

Control

Control
. Control action.Input setting
DL/D0/SN-registration. ALK(Alarn mode... )

-

B Output processing

B Relw

L] Tuning setting

B External looe setting

L} 12 83 1] 15 L]

2. Press the #1 soft key (Control action, Input setting).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of the value according to the following figure, and press the DISP/ENTER key.

Secondary |41o020 mADC  of the control input terminal block
of the control input terminal block
of the control input terminal block

Control valve of the control output terminal block

IM 04L31A01-02E
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Examples of Control Setup Operation

Setup Hode
Control{Contral action.Input setting)
rControl action Mheut setting——————————
PID number [] Loop number 1
Control period 250ns
Zone PID [ off Burnout -
Restart mode Continue Heasurel Up
I Heasure2 | U___ 1L —SelectTem or
Initial PID PressiFlou —Remote— | b Press+Flow
6/41oop select 61oop RJC

futo tuning | off w-—“ Select 1
L (No need to set loop 2)

Loop number 1 — [ Heasure2 Internal

Control mode Cascade Remute Frmtermat Select Cascade
PID control mode | Follow-up
On off

4. Press the ESC key to return to the basic control setting menu.
5. Press the #3 soft key (Output processing).

Setup Hode

Control(Qutput processing)
utput processing

Loop nunber:

1 2 3 1 5 6

6. Press the 2 soft key.
There are no control output settings on loop 1 (primary loop of cascade control).

7. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

Setup Node

Control{Output processing)
utput processing

Loop number [ 2 Select 2
Control output Select Current-output
Cucle time 3 s
fAnalog-output type 4-2BnA Select 4-20mA

* No need to set
Cycle time

Relay | Voltage | Current | On/Off

8. Press the ESC key twice to return to the menu display (basic setting mode 2/2).
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Examples of Control Setup Operation

9. Press the End soft key.
A confirmation window shown below opens.

Do you want to store and make

the new settings take effect?

Com M No  MCancel

10.Press the DISP/ENTER key to confirm the settings.

Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu
shown below.

Setting node(Control)
Contral ineut range
B control alarn
Operation-related paraneters/Zone PID
T Fio rarameters

Contral srowm setting

Ten-sement |inearizer 10

JTETION (KT Detai led (DID nonitor and operation.etc...)
[8 ] Control nath setting

|| | hext 172

2. Press the #1 soft key (Control input range).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
To set the measurement span (span lower/upper-limit, press the Input soft key to
open a numeric entry pop-up window as shown in the figure below. Enter the value
using the Character/Number key and the Space soft key and then press the DISP/
ENTER key.
Setting the Input Range on the Primary Loop of Cascade Control

GROUP 1 o]
Oct. 5. 2082 2p-pp-pe oo 01" NN hour ®
Control input range
rInput range
Loop nunber lT \ Control mode : Cascade control \ Select 1
Input tupe PV1
Hode RTD B Select RTD
Range PT Fitter Select PT
Span
Lower-Tinit 8.8 Set to 0.0
Upper-Tinit Set to 100.0
position.
2.lUse DISP/ENTER key to

define the input parameter.

Numeric entry pop-up
Samre root [0 e ESTake o cancel the RN

4. Press the DISP/ENTER key.
A confirmation window shown below opens.

&) Do vou really want to change the settings?

veso| TN

5. Press the DISP/ENTER key to confirm the settings.

IM 04L31A01-02E
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Examples of Control Setup Operation

6. Set the input range of the secondary loop of cascade control in a similar fashion as
described in steps 3 to 5 and according to the figure below.

If you do not carry out steps 4 and 5 and change Loop number, the settings are not

saved.

Setting the Input Range on the Secondary Loop of Cascade Control

o
One s 2002 co-pa:sy g D1sP NN thour @)
Control input range
rInput range
Loop number [ 2 - [ Control mode - Cascade control |
Input twpe | PUT
Hode 15V Bias —er—
Tupe DCY
Range [ Filter 0ff
Span
Lower-Timit 1.998
Upper-Tinit [ 5.688
Scale
Lower-Timit B.88
Upper-Tinit 100.08
Unit HPa
Square root

Select 2

Select 1-5V

Set to 0.00
Set to 1.00
Set to MPa

On 0ff

Setting Control Alarms in Setting Mode

1. From the operation display, click the MENU key to display the control setting menu.

2. Press the #2 soft key (Control alarm).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure.

The numeric value of the alarm is entered using the pop-up window that appears by

pressing the Input soft key.
Setting Alarms on the Primary Loop of Cascade Control
Select PV-High

Select On Select On
Select PV-Low Select DO001
Select 1 Select DO002
l.' 05,20 B:p : P 0 (o]

Rel
Tupe Standby Out Nuribe fAction
n PV-Hig 0ff On DOBE; Energize
hn PV-Low [ off [ On" D0BB2  Energize

SP nunber 1 Select 1
ue

99.08 Set to 90.0
78.89 Set to 70.0

o N
=
=
o B |
=
S|

4. Press the DISP/ENTER key to confirm the settings.

5. Set the alarms of the secondary loop of cascade control in a similar fashion as

described in steps 3 and 4 and according to the figure on the next page.

If you do not carry out step 4 and change Loop number, the settings are not saved.

18
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Examples of Control Setup Operation

Setting Alarms on the Secondary Loop of Cascade Control

Select PV-High

Select On

Select 2

GROLP 1 &
Oct. B5. 2082 28:07:50 ‘A

Select On
Select DO003

Control alarm

[ Alarn
Loop ngmber 2

Relay
Standby Outdut Number _ Action
off On DOBBE3  Energize

Select 1

Set to 0.90

A
=
=
=
=
=

Setting PID Parameters in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #4 soft key (PID parameters).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numerical values such as the SP are entered using the pop-up window that
appears by pressing the Input soft key.
Setting PID Parameters on the Primary Loop of Cascade Control

GROLP 1 =
Oct.25. 2082 20:09:31 ee D15 NN 1hour @ s}

PID parameters

Select 1
,_— Select 1

r  PID parameters

Loop number | 1

|_— Setto 80.0

Hanual reset

Derivative time<D} [IRRLLIN
Output lower limit [
Output upper linit [ 168.8 2

[50.8 %

PID nunber (17 || — Select Reverse

Target setpoint 80.8 ""ﬁ;;;;;;)ﬂirect Reverse

Proportional band(P} [ 28.8 % = Set to P=20.0%, 1=300s,
Integral time(I) | 5 D=60s

4. Press the DISP/ENTER key to confirm the settings.

5. Set the PID parameters of the secondary loop of cascade control in a similar fashion
as described in steps 3 and 4 and according to the figure on the next page.
If you do not carry out step 4 and change Loop number, the settings are not saved.

IM 04L31A01-02E
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Examples of Control Setup Operation

Setting PID Parameters on the Secondary Loop of Cascade Control

GROUP 1 o]
Oct. 5. 2082 2-10:21 e 01" NN 1hour @ *) Select 2
PID parameters elect
r PID parameters _— Select 1
Loop number n—/
PID number 1
|| — Select Reverse
Target setpoint [N Reverse/Direct Reverse
Proportional band(P} [ 128.8 = Set to P=120.0% I=20 s,

Integral tine{I} I D=0s

Deriuative tinecD> (No need to change the
Output lower limit . . P
Output upper limit |1 settings if the initial PID
Shutdown Off values are set for

Hanual reset Press+Flow)

n
=
=
)

1 2 3 1 5 6

Control Setup Example 3: Loop Control with PV Switching
Object of Control and Description

TLoop 1 PV input terminal

of the control input terminal block
2 Loop 1 current output terminal

of the control input terminal block
3 Relay contact output terminal

PV1
—

LOOP1 PV1!
LOOP1 PV2!

PV2 E : of the control output terminal block
] \DIGITAL IN® | LOOP1 mA?
Dlslr|+buto Ec\’ln?;véﬁ:mugt 4 to 20mADC
ALM P current output

Switching valve

Loop number: 1

PID constant: P=120%,1=20s,D=0s

Control direction: Reverse

Input type: 1-5 V for both measurement input 1 and 2
Measurement span: PV input 1: 0 to 300 kg/h, PV input 2: 0 to 30 kg/h
PV range conversion: Lower limit: 0 kg/h, Upper limit: 300 kg/h

Flow rate setpoint: 100 kg/h

Input switching condition: Contact input

Basic Control Settings
1. Show the show the basic control setting menu.

See “Control Setup Example 1” for the steps to show the menu.

Satup Hode

Control
Contral action.Ineut setting
DL/D0/SN-registration. ALK(Alarn mode... )
Dutput processing

Belwy

Tuning setting

External looe setting

zoEnnm =

20
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Examples of Control Setup Operation

2. Press the #1 soft key (Control action, Input setting).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

Ethernet

Setup Node Link
Control{Control action,Input setting)

rContrel action Mnput settine—————

PID number 8 Loop number 1

Control period 250ns

Zone PID 0ff Burnout

Restart mode Continue Measurel Up

Heasure2 | U __ 1L —Select Press+Flow

Initial PID PresstFlon —Remote— | Up

6/d1oop select 61oop RJC

futo tuning OFF Heasurel Intern H—— Select 1

Loop number T — | i Heasure2 Internal |l_— Select PVSwitching

Control mode PUSwitching [ | Remote Internal
Hethod Signal Select Signal
PID control mode | FolTow-up

On off

4. Press the ESC key to return to the basic control setting menu.

5. Press the #3 soft key (Output processing).

6. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft key of
each value according to the following figure, and press the DISP/ENTER key.

Setup Hode

Control{Qutput processing)
utput processing

Loop number [ 1 Select 1
Control output Select Current-output
Cycle time 3 8§
finalog-output tupe 4-2BnA Select 4-20mA
* No need to set
Cycle time

7. Press the ESC key twice to return to the menu display (basic setting mode 2/2).
8. Press the End soft key.
A confirmation window shown below opens.

Do you want to store and make

the new settings take effect?

Com M No  MCancel

9. Press the DISP/ENTER key to confirm the settings.

Setting the Control Input Range in Setting Mode

1. From the operation display, click the MENU key to display the control setting menu
shown below.

i B e m— e )

Setting mode{Control)

Contral imput ranse
B ool alarn

Operation-related paraneters/Zone PID
T Fio rarameters

Contral srowm setting

Ten-sement |inearizer 10

LTI [T ] Detai led {010 nonitor and operation.ete...)
[CB ] Control nath setting

e | 5| | ext 172 |
2. Press the #1 soft key (Control input range).
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Examples of Control Setup Operation

3. Press the arrow keys to move the cursor (blue) to the Input type box, press the PV1
soft key, and set other parameters as shown in the figure below.

GROUP 1 =
Oct. 5. 20m 20:18:41 e OISP NN 1hour =]

Control input range

— — — Checkthat1is

rInput range
Loop rumber [T TPV switching control ‘ selected
Tnput type [ PVT Select PV1
Hode 1-5Y Bias —r3 Select 1-5V
Tupe DCV
Range By Filter off
Span
Lover-Timit 1. 088
Upper-Timit 5. 068
Scale
Lower-Tinit [N Set to 0.00
Upper-Tinit 300.90 Set to 300.00
Unit ka/h Set to kg/h
Square root

On 0ff

4. Press the DISP/ENTER key.
A confirmation window opens.

5. Press the DISP/ENTER key to confirm the settings.

6. Press the arrow keys to move the cursor (blue) to the Input type box, press the PV2
soft key, and set other parameters as shown in the figure below.

GROUP 1 o]
Oct. 5. 2082 2-18:41 oo 01" NENNNNN 1hour ®
Control input range

., —— Checkthat1is

rInput range
Loop number [ 1 - Py Switehing control selected
Input twpe | PVZ Please set PV range. Select PV2
¥ode 1@! Bize —OH Select 1-5V
ype
Range [ Filter off
Span
Lower-Timit 1.po8
Upper-Timit 5.p08
Scale
Lower-linit [N Set to 0.00
|JI.Ip;)er—limit 3uh. 3 Set to 30.00
i ke/| Set to kg/h
Square root g

On 0ff

7. Press the DISP/ENTER key.
A confirmation window opens.

8. Press the DISP/ENTER key to confirm the settings.

9. Press the arrow keys to move the cursor (blue) to the Input type box, press the
PVrange soft key, and set other parameters as shown in the figure below.

GROLP 1 =
Oct.25. 2082 29:21:31 ee D15 NN 1hour @

Control input range
rInput range

Loop rumber [ 1 - W ‘
Input type  |PVrange- Please set PV range.

PV range

Lower-Timit 0./
Upper-Timit 300.08
Unit

10.Press the DISP/ENTER key.
A confirmation window opens.
11.Press the DISP/ENTER key to confirm the settings.

Check that 1 is
selected
Select PVrange

Set to 0.00
Set to 300.00
Set to kg/h

22
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Setting PID Parameters in Setting Mode

1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #4 soft key (PID parameters).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.

The numerical values such as the SP are entered using the pop-up window that
appears by pressing the Input soft key.

GROUP 1
Oct.B5.2002 209:19:38 “Aw
PID parameters

& oisr D 1houwr @)

Select 1

PID parameters
Loop number | 1

— Select 1
| — Setto 100.0

Integral time{I}
Derivative time{D}
Output lower limit
Output upper limit
Shutdoun

Proportional band{P} |RiF{N]

PID number 1 Select R
|| — Select Reverse
Target setpoint 1608.8 “"REU;F;;;hirect Reverse

= Set to P=120.0%, 1=20 s,
D=0s
(No need to change the

2 s

Hanual reset

0 %
mg_g H settings if the initial PID
0ff values are set for
50.0 % Press+Flow)

4. Press the DISP/ENTER key to confirm the settings.

Control Setup Example 4: ON/OFF Control
Object of Control and Description
CX2000

TC

PV

| LOOP1 PV'

Electric
furnace

TLoop 1 PV input terminal
of the control input terminal block
2 Loop 1 voltage relay contact
output terminal of the control
output terminal block

LOOP1 NC/NO?
ON/OFF
control output

Loop number:
Control direction:
Relay hysteresis
Input type:
Measurement span:
Output type:

1
Reverse

Setpoint: 10.0, activation position: center
TC K type

0to 1200°C

ON/OFF control output

Temperature setpoint: 700°C

Basic Control Settings
1. Show the basic control setting menu.

See “Control Setup

Example 1” for the steps to show the menu.

Satup Hode

Control
Contral action.Input setting

Contact input-registration/fli(Alarn mode...}
Dutput processing
Relay

Tuning setting
External loon setting

soEnn=

IM 04L31A01-02E
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2. Press the #1 soft key (Control action, Input setting).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

Setup Node

Control{Control action,Input setting)

Ethernet

Link

On 0ff

rControl action Mnput settine—————

PID number 8 Loop number 1

Control period 250ns

Zone PID [ off Burnout

Restart mode Continue Heasurel Up

Heasure2 Up

Initial PID Tenp Bemote i Select Temp

6/41o00p select 6loop RJC

futo tuning 0ff Heasurel Internal

Loop nunber: 1 Heasuret—Trternat- Select 1
Control node Single Remute fimtermat Select Single
PID control mode | FolTow-up

Press the ESC key to return to the basic control setting menu.

4.

5. Press the #3 soft key (Output processing).

6. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and

h

Control(Qutput processing)

Setup Hode

utput processing

press the DISP/ENTER key.

Select 1

Loop number 1

Control output On/0ff-control
Cycle time 3 S
Analog-output type 4-20nA

Relay | Voltage | Current | On/0ff

Select On/Off-control

*No need to set
Cycle time and
Analog-output type

7. Press the ESC key twice to return to the menu display (basic setting mode 2/2).
8. Press the End soft key.

A window appears for you to confirm the saving of the new settings.
9. Press the DISP/ENTER key to confirm the settings.

Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu

shown below.

B o EEEE ihor 1]

Setting mode{Control)

T centrol ineut range

B control alarn

Operation-related paraneters/Zone PID

T Fio rarameters

Control srowm setting

Ten-segment linearizer 110

ST BT Detai led (DI0 noniter and operation.etc...)
[__B8 ] Control math setting

| ext 172 |

24
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2. Press the #1 soft key (Control input range).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric values of the lower/upper limit of range are entered using the pop-up
window that appears by pressing the Input soft key.

GROLP 1 =)
Oct.B5.20082 20:22:54 ‘Aee DISP

I 1hour

®

Control input range

rInput range
Loop nunber l—l _meMnala look _eantral ! Select 1
Input type 21 Select PV1
Hode [TC Btas —or— Select TC
Range K Fitter —ort Select K
Span
Lower-Tinit 5.8 Set to 0.0
Upper-linit 1268.8 Set to 1200.0
Square root 0ff
On off

4. Press the DISP/ENTER key.

A confirmation window shown below opens.

&) Do vou really want to change the settings?

veso| TN

5. Press the DISP/ENTER key to confirm the settings.

Setting Control Parameters in Setting Mode

1. From the operation display, click the MENU key to display the control setting menu.

2. Press the #4 soft key (PID parameters).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric values of the target setpoint and relay hysteresis setpoint are entered
using the pop-up window that appears by pressing the Input soft key.

GROLP 1 ]
0ct. 852002 20:23:50 o DISP NN lhour ®
PID parameters Select 1
r PID parameters L— Select 1

Loop number | 1 | Setto 700.0

PID number 1 Select R

|| — Selec everse
Target setpoint 768.8 —FRavarse/Direct Reverse — |
Preset output 0.8 %

Relay hysteresis

Position

Value 168.8
| Hid |

Set to 10.0

Select Mid

Hid LEL Low

4. Press the DISP/ENTER key to confirm the settings.
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Setting the Display Items on the Control Group Display (Control Group Setting)
Below are the procedures for displaying loops 1 to 5 and measurement channel (input
channel for measurement) 1 on the control group display (group name: CONTROL
GROUP 1) of group number 1.
1. From the operation display, click the MENU key to display the control setting menu
shown below.
Al B o EEEE ihor [t=1]

Setting mode{Control)

T centrol ineut range
“tumol alarn

Operation-related paraneters/Zone PID

BT 710 sarancters
Control srow setting
Ten-segment linearizer 110

ST BT Detai led (DI0 noniter and operation.etc...)
[ B8] control nath setting

T || | Hext 172

2. Press the #5 soft key to show the Control group setting display.
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
Select On

Select Int-Loop or Meas CH

If internal loop, select the loop number.
If measurement channel, select the channel number.

GROUP 1 =
Oet. 5. 20m2 28:25:57 e OISP NN 1hour =]

Conttol group
Group number 1
Group ham [ CONTROL|GROUPT
ind unbbr  Tag Tag comnent
1 [ o Tnt-Loop [ TIC-181
2 [ On Tnt-Loop g2 TIC-182
3[ On Tnt-Loop g3 TIC-183
4 [ 0n Tnt-Loop B4 TIC-184
5[ 0n Tnt-Loop g5 TIC-185
6 [ on gl TIC-88

Int-Loop | Ext-Loop | Heas-CH

Tag display
(Tag is set using the #3 Operation related/zone PID
setting display)

4. Press the DISP/ENTER key to confirm the entry.

Control Group Display Example after Setup

S reag 0 017 NN thor )
TIC-182 TIC-183
= | MAN

o

*CPY

— Control status
S T8 O  600.8 display of

0T 0.8 %oUT 8.8 internal loops
TIC-104 TIC-185

HAN = MAN ™ 1035

Py “CPV

)~ Measured value
measurement

hannel 1
moe | s | our | RSP | TUHIKG c¢hanne

26
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Displaying the Trend of PV, SP, and OUT Values

Below are the procedures for displaying the trends of PV, SP, and OUT of loop 1 on the
trend display of group number 1 (group name: GROUP 1).
1. From the operation display, open the Group set, Trip line setting display according to

the following procedure.
Press the MENU key (to switch to Setting mode (Control)) and then the MENU key
(switch to Set mode). Press the #4 soft key (to select Display) and then the #1 soft
key (to select Group set, Trip line).

Menu (Setting mode (Control)) Menu (Setting mode)

GROUPT ey =
R -2r-7 g 01 NN or

Setting mode(Control) S5 o
Contral input range TR farse Alarn
B cootrol alarn I Tes-toving averase.hlarn delay
Goeration-related paraneters/Zone P10 Trend/Save interval,Messsoe.File.lser key
T 0 caraneters B oo
Control srow setting —> D SsverLoad, Clear data
Ten-segment linearizer 110 . Tine
[T BT Detailed (DID nonitor and cperation.etc...) T T tath et
[ B8] control nath setting B | Hath sst2
s TSR 12| i e RSeS|

~

GRO e ™
T 7eo 0 015 N thour

Diselay

Display
L]
©
14
L
15
L]
”
"

Group sat.Trip line
Calar

Zone, Grach
View.Direction.LCO
Comtrol{Calor)
Control{Zene. Grash}
MathiColer}
ath{Zone. Graph}

- N, o2 | o m | M |5 45 [Next 1/2

2. Press the arrow keys to move the cursor (blue) to the Channel setting box.
3. Press the Input soft key to open the channel input pop-up window.
4. Use the Character/Number key and soft keys to select the channels to include in

the group.
In this group setting, the PV, SP, and OUT of loop 1 are assigned channel numbers
101, 102, and 103, respectively. To include PV, SP, and OUT of loop 1, enter 101-
103 or 101.102.108.

ot 0520 po-0c0s G D1 N thor (S

Display(Group set.Trip line)

Group humber
1

Select 1

Group set

Group name GROUP 1
CH set B1-18
Trip line

Enter 101-103

101-183

1.Use double(Heasure) or triple(Control)
digit to express channe| nunber.

2.lUse "BO-BA° or 'OOA-8BB° style
for channel’s number ranse.

N
[ =1k=ik=d
h={ B4 o
s i

0ff 3.Connect channel nunbers with °.°. ch li t
4.Entry exanple for CHL.CH3. anne |_npu
CH5,CHB,CH7,CH8 and CH1B1. pop-up window
B1.83.85-88. 101
Del Bs Ins

5. Press the DISP/ENTER key to confirm the entry.
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Displaying the Trend of PV, SP, and OUT Values

Note

You can select up to 10 channels from measurement channels (CH1 to CH20), computation

channels (CH31 to CH60), internal control channels (CH101 to CH118), and external control
channels (CH201 to CH248) using Channel setting.
+ Assignment of internal control channels (channels of internal loops)

The data of 6 loops is assigned to channel numbers as follows:

Loop 1 PV: 101, Loop 1 SP: 102, Loop 1 OUT: 103

Loop 6 PV: 116, Loop 6 SP: 117, Loop 6 OUT: 118
+ Assignment of external control channels (channels of external loops)
The data of 16 loops is assigned to channel numbers as follows:
External loop 1 PV: 201, External loop 1 SP: 202, External loop 1 OUT: 203

External loop 16 PV: 246, External loop 16 SP: 247, External loop 16 OUT: 248
Set the channels to assign them to a group according to the following rules.
+ Enter the channel number using two or three digits.
+ Separate each channel with a period.
Use a hyphen to specify consecutive channels.

Example: To assign CH1, CH3, CH5 to CH8, and CH101, enter 01.03.05-08.101.

Trend Display Example after Setup

|l5 BAZ 2A T B e
1ninAdi il P
T [ H  77.00
SP'\ ¢
b rgn MO0 W
ey ||
I ouT /\ 77.02
|
71.0
N 2
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Switching the Operation Mode

For details on the procedure for switching the operation mode, see chapter 6,
“Operations during Control Operation” in the CX2000 User’s Manual (IM 04L31A01-01E).
The following is a procedural example on the control group display.

Run/Stop Operation
For cascade control, the following operations can be performed only when the secondary
loop is selected.

1. Use the arrow keys to move the cursor to the desired control loop.
Cursor (®)

oo 180001 gh-an:s e 01 N thour 116 (5)
INT-81 INT-62 INT-83 INT-B4 INT-85 INT-86
MnN Lo¢ TR MnN Loc STP MnN Loc STP MnN Loc STP MnN Loc STP MnN Loc STP
2. Press the RUN/STP soft key.
A pop-up window for running and stopping the operation appears.

Window for starting and
stopping operation

3. Select RUN or STOP using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Switching between Auto, Manual, and Cascade Control

You can only switch to the cascade mode on the secondary loop of cascade control.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the Mode soft key.
The MODE selection pop-up window appears.
INT-81 INT-82

MAN Loc TR MAN Lot STH
PV °C | PV C
+Hkkkkk | blokiokk

AR
-200.8 | -200.
oor g o
8.e

1378.8

114.8

- 208, 8

HODE | HODE R MODE selection window

3. Select AUT (auto), MAN (manual), or CAS (cascade) using the up and down arrow
keys.

4. Press the DISP/ENTER key to confirm the changes.
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Switching the Operation Mode

Changing the Target Setpoint
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the SP soft key.
The SP modification pop-up window appears. The window shows the current target
setpoint.

MAN Loc TR
Py °t
+ikkkokk

Window for changing the
target setpoint

3. Change the target setpoint using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Changing the Control Output
The following operation cannot be performed during auto operation, when operation is
stopped, or when the primary loop of cascade control is selected. When the operation is
stopped, the preset value is output.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the OUT soft key.
The OUT maodification pop-up window appears. The window shows the current
control output.

—20A . A -288.8

Window for changing the
control output

3. Change the control output using the up and down arrow keys.
The control output is set to the new value at this point.
4. Press the DISP/ENTER key to complete the procedure.

30 IM 04L31A01-02E



Switching the Operation Mode

Switching between Remote and Local Modes
The soft key menu does not show REM/LOC, if Control > Contact input-registration/
AUX(Alarm mode... > Remote setting is set to Off. Remote input cannot be used for the
target setpoint when the secondary loop of cascade control is selected or during program
control. Thus, there is no remote/local switching in these cases.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the REM/LOC soft key.

A pop-up window for switching between remote and local appears.
INT-81 INT-82

MAN Lor: 5T MAN Lo §TR
Py °C P °C
+Hkkkk | HRkkkk
SP C S C
-208.8 | -200.08

ar 3| T 3%
8.8 6.0

1378.8 1378.8

1656.68

428.8

1148 114.8

200, A -260, 8
REF/LOC =  REMOTE [-% Window for switching between
remote and local

3. Select REMOTE or LOCAL using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Switching between Automatic and Manual for the Analog Retransmission Loop
You can switch the output mode for the control loop specified for analog retransmission.
When set to AUTO, the computed result of analog retransmission is output. When set to
MAN, you can set the direct output value.

1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the MODE soft key.

A pop-up window switching between auto and manual appears.
INT-82
MnN Loc ST
PV °

Hhkkkk
T
-200.8

AN
6.0 8.8

108.8

HODE = AT 5| —— Auto/manual switching window

3. Select AUTO or MAN using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.
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Switching the Operation Mode

Changing the Analog Retransmission Output
MAN must be set for the MODE using the procedure above.
1. Use the arrow keys to move the cursor to the desired control loop
2. Press the OUT soft key. The Output Value Setting window appears.

MODE| oo = .42+

3. Change the output value using the up and down arrow keys. The currently set
control output value is displayed in the window.

Switching between Automatic and Manual for the DIO Operation Monitoring
You can switch the output mode for the DO specified in the DIO Operation Monitoring

Function. When set to AUTO, the internal switch status is output. When set to MAN, you

can switch the direct output value between 0 and 1.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the MODE soft key.

A pop-up window switching between auto and manual appears.

D10-881 DI-881

HODE HaN |—5——— Auto/manual switching window

3. Select AUTO or MAN using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Changing the DO Output for the DIO Operation Monitoring
MAN must be set for the MODE using the procedure above.
1. Use the arrow keys to move the cursor to the desired control loop
2. Press the OUT soft key. The Output Value Setting window appears.

MODE| oot = ==

3. Change the output value using the up and down arrow keys. The currently set
control output value is displayed in the window.
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Tuning Operation

For details on the procedure of switching the operation mode, see chapter 6, “Operations

during Control Operation” in the CX2000 User’s Manual (IM 04L31A01-01E).
Displaying the Tuning Display

Press the TUNING soft key on the control group display.

[[E3 —51n|n I 16

@ D5 NN Slnin 1/16 @ )
BENT e e

LD Tic-im

EVENT I

C TIC-182
nm-l-; e HFIN“

001

S 77.00 600.0

ouT 0.8 : our 0.0

TIC-184 TIC-185 Tic-ga1
HeN o

kkkk ikkkk 244, 7

5P 61.8 *CsP 115.9 °C
ouT 0.8 % oUT 8.8 ]

LW
Lo
1L.m
1L.H

1R
1.F0

MOE | o [AmoTIN| N0 [P M. | CTRL G| RSP |

Auto Tuning
To execute auto tuning, Basic setting mode > #10 Control > #1 Control action, Input
setting > Auto tuning must be turned On before carrying out the following procedure.
1. Press the AUTO TUN soft key on the tuning display.
As shown in the following figure, the auto tuning setup pop-up window appears along

with a warning message.

TIC-181 &5 DisP — 51|n|n 1/16 o)
Oct.05.2002 20:46:18 "7 EVENT NN W
1.9 =77.00 Ly =1 TIC-181
1.AL  =38B.00 1.04  =180.0 AUT e
1.02  =50.08 1.0 =08
1.A3  =50.08 1.HR  =58.8
1.04  =108.00 1.H =0.58
1.p = == —
PR *\ UARNING!
When on-off control is being used, auto-tunis cannot be

controlling any of the following processes:

- Control process with auick response such as flow control
or pressure control

- Process where even temporary output on/off results in
i neonveni ence

- Process where a large output change at control element
results in inconvenience

- Process where variations in PV nay exceed an allowable
range, adversely affecting product quality

Auto tuning setup window
2. Select the control loop using the up and down arrow keys.

MODE 0UT | AUTO TU AT = 1[~%[RL GRP | RUN/STP

3. Press the DISP/ENTER key to execute auto tuning.

CAUTION

» You cannot execute auto tuning during ON/OFF control.
+ Do not execute auto tuning when controlling the following types of processes. If
you do, malfunction may occur in the control process.
» Control process with fast response such as flow control and pressure control.
» Processes that result in adverse consequences when the output is turned on/off
even if temporarily.
* Processes that result in adverse consequences if a large output change is
applied to the control element.
» Processes that may cause adverse effects on the quality of a product when the
process value exceeds the allowed fluctuation width.

IM 04L31A01-02E 33



Tuning Operation

Manual Tuning
1. Press the arrow keys on the tuning display.
A cursor appears in the control parameter display section.
2. Select the control parameter you wish to change using the arrow keys.
3. Press the DISP/ENTER key.
The parameter modification pop-up window appears.
(‘:ursor (®)

TIC-161 &5 DISP NN Sinin 1/16 o)
Oot. 5. 202 20:47:02 ‘v EVENT IS B W B

1.6 =77.08 1.D =1 TIC-181
1.a1  =383.98 1.00  =108.8 AUT ! mﬁ

Control t = 50.08 1.0L = 0.0
ontrol parameter = 59.88 LR =50.8

display section ) = 10000 LH = B.50
=11.8 1.DR = REVERSE
=1 1.0 =08

AT = OFF SP No. =1 PID No. =1 GROUP No. =

Window for changing parameters

4. Change the value using the up and down arrow keys.
5. Press the DISP/ENTER key to confirm the changes.
To close the window without making any changes, press the ESC key.
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Program Control Function (/PG1 and /PG2 Options)

Program Control Function Introduction

Program control function is used to ramp-up or ramp-down the SP according to a
program pattern. The number of program patterns that you can create with the CX2000
is as follows:

+ /PG1 option: 4

+ /PG2 option: 30

Up to 99 segments can be specified in a single pattern.

sp—

/PG1: 4 patterns
/PG2: 30 patterns

—— Time —~
Segment

Operation Mode during Program Control

The following 4 types of operation modes are available.

program control.

Reset mode st ReITTL Local operation mode
The program control of all loops is stopped. °| p aflfoops. When switched to local operation mode
All event outputs are cleared (off). R even during program control,
Start loop fixed-point operation is carried out
operation. according to the SPs specified locally.
Start | } Reset. Start switch | Tswitch the loop to local.

End program to reset.

rogram control he |
Stop all loops. prog the loop End program to local.

to program control.

—— e ———

Program control mode Hold operation mode
Control operation is being carried out Clear hold. The raising or lowering of the SP
according to the program pattern. B E— according to the program pattern
—_——

during program control

Execute hold. is forcibly held such as through key operation.

/
—_—_—— - - - —

Program in operation

Operations on the Program Selection Display (See the figure on the next page)

Displaying the Program Selection Display
On the control group display or control overview display, select CONTROL >
PROGRAM from the screen selection menu.

Starting Program Control

Program control starts, and the screen switches to the Program Control Display.
1. On the Program Selection Display, press the RUN soft key.

A pop-up window for starting the program control appears.

Window for starting
the program control

RN [)PTNO. |/ -tesei RN = RUN|-SPNPNChENTt72t

2. Press the DISP/ENTER key.

IM 04L31A01-02E
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Program Control Function (/PG1 and /PG2 Options)

Program pattern
name

* The selected
segment is the
segment displayed
at the left end.
Select the segment
using the left and
right arrow keys.

Selected pattern
number

Selected segment*
number

Selected segment*
time

Program Selection Display Example

Program 1
Mar.29.2002 19:87:49 E= EVENT NN N B
2nin/div 500.0 I!lT—ﬂl

== DISP N lhour 4/16 @
u

Preset ;] ) 7 iN— Target SP display of the

pattern = selected segment*
waveform L
A
1300.0 -

Repeat frequency Segment rang

to be repeate: 168
: B1 (8 B (A1 -16 ﬁ&art segment number display
B AR i ok [
BA:02:08 DELA A : B8 B8 =— Display the program pattern
RUN | PT NO. |SET PTNO | OVERVIEW | CTRL GRP | RUN PNL | NEKT 1/3 control start delay time

I
Show the program control display
(valid only during program control)
Switches to control group display (style number S3 or later)
Switches to overview display (style number S3 or later)

Settings for pattern to be run as a result of communication function,

DI/DO, or internal switch action
Switch the program pattern

Display the window for starting the program control

Soft key menu 2/3

-3

LL/D1Y | Dsp LooP | ST SEG | DELAY TH |EV ON/OFF| EY KIND | NENT 273 |
I

Display soft key menu 3/3

Display the selection menu for the event display method
(style number S3 or later)

Turns the event display ON/OFF (style number S3 or later)
Display the window for setting the program pattern control start delay time
Display the window for setting the program pattern start segment
Display the ON/OFF selection menu of program pattern display loops

Switch full display/split display
Soft key menu 3/3
-1BSEG | +1BSEG | TAG/CHT | WDisplay soft key menu 1/3

f
| Switch tag/tag comment display
Shift the displayed segment by +10 segments

Shift the displayed segment buy —10 segments

Operations on the Program Control Display (See the figure on the next page)
Displaying the Program Control Display

When you start the program control on the program selection display, the program
control display appears. You can display the program control display when program
control is in progress by selecting CONTROL > PROGRAM from the display
selection menu on the control group display or the control overview display or
pressing the RUN PNL soft key on the program selection display.

Executing and Clearing the Hold Operation

You can hold the progress of the program (stop the timer). While in hold, you can
change the segment SP or increase or decrease the remaining segment time.
Press the HOLD soft key.

A pop-up window for executing/clearing the hold operation appears.

= Window for executing/
RUVRST | awahce(] oo LD = OFF[ < e clearing the hold opcfration.

Select [ON] (execute) or [OFF] (clear) using the up and down arrow keys.
Press the DISP/ENTER key.

36
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Program Control Function (/PG1 and /PG2 Options)

Resetting Program Control
Resets the program control and stops.
1. Press the RUN/RST soft key.
A pop-up window for starting and resetting program control appears.

(_\D‘ — Window for starting and
RUN/RST [)nDWANCE || HoLD[ RUNRST =  RESET[-= resetting program control

2. Select [RESET] using the up and down arrow keys.
3. Press the DISP/ENTER key.

Program Control Display Example

Program pattern el DIsP [N 550in 316 (D) ___Tag/Tag comment
name display =

]' PV, SP, and OUT

PV waveform
(solid line)* — Cursor indicating the program

Preset pattern execution position
waveform

(SP, dotted line)

Control pattern
number \!. ji__— Repeat frequency and repeat

Control segment \!E- _ : count values
S M_— Repeat segment range

_~Displays wait time when in wait
mode

SEGHENT TIHE: 6A:68:19 f ;
RUN/RST | ADVANCE | HOLD | OVERVIEW | CTRL GRP | SEL PNL | NENT 1.2

“— Remaining time ofthe control
segment

HOLD (blinking):
Hold mode
WAIT: Wait mode

|
| Show the program selection display
Switch to control group display (style number S3 or later)

DELAY: Program pattern Switch to overview display (style number S3 or later)
control being Hold the program
delayed Advance the program

Display the window for starting program control and resetting

* PV waveforms are

Soft key menu 2/2
displayed when you 4

press the START _ ALL/DIV | DSP LOOP | TAG/CHT |EV ON/OFF| EV KIND | NEXT 22 |

key to start the data

acquisition to the Display the selection menu for the event display method
internal memory. (style number S3 or later)

Turn the event display ON/OFF(style number S3 or later)
Switch tag/tag comment display
Display the ON/OFF selection menu of program pattern display loops
Switch full display/split display

Soft key menu when in hold mode
RUN/RST | ADVANCE | HOLD | SEG TIME | TSP cHa | SEL PNL | NENT 143
|

Display the menu for selecting the loop of which
the target SP is to be changed
Display the window for changing the remaining segment time

OVERVIEW | CTRL GRP | ALL/DIV | DSP LOOP | TAG/CHT [EV ON/OFF| NEXT 2/3 |
EV KIND NEKT 373

Switching between Program Control and Local Control for Each Loop
Press the PRG/LOC soft key on the control group screen to switch between program
and local.
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Program Control Function (/PG1 and /PG2 Options)

Executing Several Program Patterns
You can execute multiple program patterns whose loop numbers do not overlap.

Switching Pattern Numbers
1. Press the PT NO. soft key in the program selection screen.
The pattern number switching pop-up window appears. The currently set pattern
numbers are displayed in the window.
2. Select a pattern number using the up and down arrow keys.
3. Press DISP/ENTER key to confirm the changed settings.
To close without saving, press the ESC key.

Program Operation Start

1. Press the RUN soft key.
The program operation start pop-up window appears.

2. Press the DISP/ENTER key. The screen changes to the program operation display.

Displaying the Program Selection Display
1. Press the SEL PNL soft key.
The screen changes to the program selection display.

Executing a Separate Program Pattern
1. Repeat the above procedure as necessary.

Switching the Displayed Pattern in the Program Operation Display
1. Press the left or right arrow keys to switch the displayed pattern.

Program Control Setup Operation

Program Control Setup Operation Sequence
First, set the control functions of the loops to be used (see below). Next, set the
program control (see page 39).

Setting the Control Operation of the Loops to Be Used

This section explains only the settings specific to the program control.
+ Control > Control action, Input setting setup screen

For a description of the setup procedure, see pages 11 and 12.

Setup Hode

Control{Control action,Input setting}
rCentrol action———————————

Input setting

|

PID number Loop number 1
Control period 250ms |
Zone PID 0ff Burnout
Restart mode Continue :easure Select the operation status when a power
';:Sff: 'P"‘l’ge(mgra“) c";:*‘-- = failure occurs during program control and
1t
RIC the power recovers.
futo tuning 0ff fieasure] « [Continue]: Continues program control.
« [Manual]: Switches the loop to manual
Loop number 1 Heasure| oper ation.
Control mode Single renote | © [Reset]: Resets program control.
Progran control [ on | ( .
PID control mode [ FolTow-up Select [On]. J

[

Next 172

38
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Program Control Function (/PG1 and /PG2 Options)

DISP/ENTER key

END(?)

Program Control Related Setup Operations

Follow the flow chart below.

For further details on each function, see section 1.11, “Program Control Related
Settings” in the CX2000 User’s Manual (IM 04L31A017-01E) provided on the

accompanying CD-ROM.

Prosran-control paraneters

fProsran-control
L Program paraneter setting
=2 Event output setting
L] Pux(Puto messase.Disolay position)
L] Aux(Event sroup)
e | e | u ]

to store and nake

fio wou wartt
tings take affect?

#1@ the new set

JS5 5 B Canca | |
4 Enp

Prosran-control paraneters(Prosran paraneter setting)

Frogran parameter setting

81 Pattern initial setting
BN

Prosran-control paranetersiProsran paraneier setiins}
Program paraneter setting
I Pattern initial setting
Vait action setting
Pattern start setting
Proaram pattern setting
Euvent setting
Husteresis(PV event}
Repeat action setting
END

Pattern mumber © 1

sszE2R

A DISP/ENTER key

MENU key (switch to the Setting mode (Control))

> Next 1/2 soft key
s

Setting noda{Contral}

#7 “ Progran-control paraneters——

I Detai led settina(D10 ponitor and
Centrol math setting
DI 91 control inout ranse
-] Control alarn
[ ¥ Geeration-relted paamaters/Zone PID
[ 8] PID paraneters

5] Control aroup setting
ESC kel y [ ¥ ] Ten-sesment linearizqr

| hext 272 |
[#7 Program-control parameters] appears
only if you set [Program control] to [On]
under [Control action, Input setting] on
page 38.

operation.etc...}

]

#1 Pattern initial setting

@ jProsran initial setting i ol
m’m Fﬁ! ﬂ—:niu events 58
#1 i T
=, R tms T
Fction loop
Loop 1
Loop 2
Lo ¢
ESC key*2 Tl
-
| ot |

Select pattern number and

V
/ y then change the settings.

ESC key*2

initial setting
Pattern nusber i1 Resaining seanents
DISPENTER [seets ™ [ M
key Pattern ram Fattern 1
{

ESC key loce -

On

oft

oft

i

| To set a single pattern, carry out steps 1 to 8.

n | v | B | 85 | 5 Next 172

+#2 to #7 @ * ESC key @ *1 If you set pattern parameters of other numbers

Change the settings on setting screens
#2 to #7.

Setup Sequence

after this step, all settings up to that point are
cleared.

*2 If you did not change the settings on the Pattern
initial setting screen

First, enter pattern initial settings (1 to 4 above).

Next, set [#2 Wait action setting] through [#7 Repeat action setting] (5 and 6 above).
Return to the Program-control parameters screen (7 and 8 above).

Set [#2 Event output setting] through [#4 Aux (Event group).]

Refer to the figure above for the following procedures.
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Program Control Function (/PG1 and /PG2 Options)

Pattern Initial Setting

GROLP 1 =
Jan.08. 2003 g7:11:07 = DISP NN 4ohour

®

Progran paraneter setting(Pattern initial setting}

Program initial setting

Pattern nunber

Segnents

Segnent setting method
Pattern nane
Segnent edit mode

I —

7
Tine \
Pattern 1.
off \\\

Enter the program pattern number.
/PG1:1 to 4,/PG2: 1 to 30

\(

Enter the number of segments to be used.

1t099

(Segment setting method:Time)

Targ

et SP

\[ Select the time or ramp-rate (see below).

Enter the pattern name (up to 16 characters).

Specify the position of the segment to be

deleted or added.

|
|
)
)
|

(Segment setting method: Ramp-rate)

Method for creating the
segment using the target

Segment time

SP and the segment time.

Target SP

/

Minute or hour Ra\te-of-change

Wait Action Setting
Set 5 types of wait actions. Specify the wait action for each segment.
R oogs pr:12:07 1= DI NN dBhour

Progran paraneter setting(Wait action setting)

®

Loopl

Loop2

Wait tine

Wait action setting
Pattern nunber

1
1 3 [

High [0ff

Low

Method for creating the segment
using the target SP and the
ramp-rate of the SP change.

Set the ramp-rate using rate-of-
change per minute (example:

2°C per minute) or rate-of-change
per hour (example: 10°C per hour).

off

Wait zone number

Select [On] to set a wait zone.

[of

Set the wait zone (engineering unit).

On

0ff

@Vait function at the time of segment switching)

Wait zone high
Wait zone low

Actual wait time

Segment 1 Segment 2
Target SP - }

L Z /
SP_ 1
s | Wait time
’ PV

(specified value)

@Vait function within the segment)

1 Wait zone high
/ Wait zone low

PV
y ;. SP
‘ T Wait time

Enter the maximum wait time when using the
wait function at the time of segment switching

(see below).

If the PV is outside the wait zone when the SP reaches the target SP
of the segment, the program does not advance to the next segment.
When the PV enters the wait zone, the program advances to the next
segment. In addition, when the wait time elapses even if the PV does
not enter the wait zone, the program advances to the next segment.
If the wait zone is set to 00:00:00, the program does not advance to
the next segment until the PV reaches the wait zone.

The advancing of the program control stops when the SP exits from
the wait zone. When the PV returns within the wait zone, the
advancing of the program control resumes. [Segment time] setting
is irrelevant for wait within the segment. The advancing of the
program control is stopped until the PV reaches the wait zone.

40
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Program Control Function (/PG1 and /PG2 Options)

Pattern Start Setting

GROLP 1 =
Jan.ps.2003 p7:12:27 = DISP NN dfhour ®

Program parameter setting(Program start setting)
[ Pattern start setting
Pattern number = 1

Start target setpoint —/[ Enter the SP of the pattern start point. J
Loop 1
Loop 2 -208.8

Start code StartTargetSP —

Select the operation when starting the program
control (see below).

Select the operation start condition (Start code) from the following.

( Start code: StartTargetSP)

Starting SP Start

Targi»SP Program starts from the starting target SP.

Ramp-rate of the SP change
Starting (specified value)
target SP

l<—> Segment time (specified value)

(Start code: RampPV1Start to RampPV6Start )

Ramp-prioritized PV1 to PV6 start

The program control starts from the SP corresponding
to the PV (PV1 to PV6) of the specified loop. For other
PV at the start /| — Starts from this SP. loops, the program control starts from the same point
of control L’ as the start point of the specified loop. The ramp-rate
. of the SP change is maintained as specified. The
segment time is shortened.

Target SP
|—>

Actual segment time
Segment time (specified value)

(Start code: TimePVStart )

Target SP Time-prioritized PV start
Ly aee The program control starts from the SP corresponding
/” /r to the PV of each loop. The segment time is maintained
PV at the start . ;\ as specified. The ramp-rate of the SP change varies
of control 7 |~ Starts from this SP. depending on the position of the PV.

Segment time (specified value)
Segment time (specified value)
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Program Control Function (/PG1 and /PG2 Options)

Program Pattern Setting
+  When the segment setting method is set to [Time]

322'_]58%2553 a7-12:47 = oise I 46hour Select the segment number.)f 0 Soak
Progran paraneter setting(Progran pattern setting Select ramp or soak. 135
rProgran pattern setting
Pattern number @ 1 -./ Enter the target SP of the segment. )
Segnent number
Ranp/Soak select Ramp /( Enter the segment time. )
Target setpoint Select the PID number to be used
Loop 1 -260.8 Loop 2 2 (Not displayed when zone PID is selected).
Select the operation when ending the segment.
Seanent tine B9-88- 81 - [Continue]: Advance to the next segment.
- [Hold]: Hold the program progress.
Segment PID group No. 1 - [Local]: End by setting the loop to local mode.
Seatent shift action Continue * [Reset]: End by stopping the loop.
Wait action Shift T
U e e 1 \\( Select the wait action type (see page 40). )
Inout A ¥  |Event set \( Select the wait zone nhumber to be applied. )

*  When the segment setting method is set to [Ramp]

GROLP 1 =
Jan.08. 2003 p7:14:57 = DISP NN 4ohour

Progran paraneter setting(Program pattern setting}

rProgran pattern setting
Pattern number @ 1
Segnent nunber
Ranp/Soak select

==

Same as the figure above. ]

Target setpoint
Loop 1

Ramp-rate time unit
Ramp

Segnent PID group No.
Segnment shift action
Wait action

-268.8 [ Loop 2 -28

Select the ramp time unit.
[Hour]: 1 hour
[Minute]: 1 minute

Hour
8.1 \‘
1

Enter the rate-of-change per unit time using
engineering unit.

Continue

off \{

Same as the figure above. ]

Input a

Event Setting
+ When the event kind is set to [TimeEvent]

GROLP 1 =
Jan.08. 2003 p7:13:08 = DISP NN 4ohour

v Event set

®

Progran paraneter setting(Event setting}

Select the segment number to which the event
is to be assigned.

Select [TimeEvent] (see below). J

Select the type of time event ([On/Off], [On/**],
or [**/Off]) (see below).

Event setting
Pattern number @ 1
Segnent nunber EE—
Event kind [ TimeEvent (
On-tine i L
1 [Onl [pE-86:6P [AA:GA:BE
2 [On2 [0-60-00 18 [0ff
3 [0n3 80:28:08 11 [off
4 [off 12 [off
5 [Off 13 [off
6 [Off 14 [Dff
7 o B
8 |off 16 [off
Input r'y v Pattern

Set the time for turning ON/OFF the contact
output in terms of the time elapsed from the
start point of the segment (see below).

Time event is a function used to turn ON or OFF the contact output after a specified
time elapses by starting the clock from the time the segment operation is started.

Up to 16 time events can be specified for each segment. There are 3 types of time events.

[On/Off]
, Segmentn, n+1

Type of time event

Event output
On- time
Off-time

_—

S E—
' ]

[On/**]
Segmentn . n+l :

[**/Off]

Segmentn . n+1

On-time

ﬁ

Off-time — >

42
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Program Control Function (/PG1 and /PG2 Options)

+ When the event kind is set to [PVEvent]

GROLP 1 =
Jan. b8 208 87:13:45 = D15P NN d8hour ©

Program parameter setting{Event settina}

" Event bsettim!1 /I Select the segment number to which the event ’
attern number : . .

Segnent nunber: is to be aSSIg‘I'led.

Event kind [ PUEuent \_{ Select [PVEvent] (see below). J

Loor! Tupe lue Loow

[T PU-Hish
i

[TT
Select the loop to which the event is to be ’

assigned.

[
Enter a value when the PV event is to be
detected using engineering unit.

[T1

N
\"L Select the type of PVEvent (see below). }

00 ~d D N B W O
olole|o|e|e|e
A e e e e

i i o {4 -4

»

Input hd Pattern

This function outputs preset alarms such as PV alarms, SP alarms, and output
alarms during program operation. Up to 16 PV events can be specified for each
segment. PV events operate only within the specified segment.

PV high-limit alarm (PV-H) example Select the type of PV events from the following.
« PV-H (PV high-limit), PV- L (PV low-limit),
Dev-H (deviation high-limit), Dev-L (deviation low-limit),
SP Dev-H&L (deviation high & low limit),
and D-W-H&L (deviation within high & low limits)
+ SP-H (SP high-limit) and SP-L (SP low-limit)
» Out-H (output high-limit) and Out-L (output low-limit)

Set value

Event output

Event Output Destination Setting
The even output destination is set using the Event output setting display (see
[Program-control parameters] display on page 39).

Repeat Action Setting
GROUP 1 P=
Jan.08.2083 o7:14:06 = DISP NN d0hour ©

Progran parameter setting{Repeat action setting)

Repeat setting
Pattern number : 1 Select [On] or [Repeat] when using the repeat
Repeat action o = action.
Repeat freauency 2 . .
Rl Sen ST ,—3\ « [On]: Repeats the specified number of
Repeat end sesnent 5 \ times

- [Repeat]: Repeats infinitely

Enter the number of repetitions when [Repeat
action] is set to [On].

Set the range of segments to be repeated. }
off On Repeat
Repeat action
Pattern created Pattern executed

Execute segment 3to 5
twice (repeat frequency: 2)

Executed twice
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List of Parameters

Below is a list of parameters for the model with the various function options. However,

settings related to the program control function option are not given.

Basic Setting Mode
#1 Alarm, A/D, Temperature

Parameter Selectable Range or Selections Initial Value
Alarm > Reflash On/Off Off
Alarm > Relay > AND None, 101, 101-102, 101-103, ..., 101-I135, or 101-136 None
Alarm > Action Energize or Deenergize Energize
Alarm > Behavior Hold or Nonhold Nonhold
Alarm > Indicator Hold or Nonhold Nonhold
Alarm > Rate of change > Increase/Decrease 1t0 15 1
Alarm > Hysteresis On/Off On
A/D Integrate > Integrate Auto, 50 Hz, 60 Hz, or 100 ms Auto
A/D > Scan interval 1sor2s 1s
A/D > First-CH 011t0 20" 01
A/D > Last-CH 01 to 20 01
A/D > Burnout set Off, Up, or Down Off
A/D >RJC Internal or External Internal
A/D > Volt (uV) —20000 uV to 20000 uV ouv
Temperatire > Unit CorF C
"01 to 10 on models with 10 measurement channels.
#2 Memory, Memory and Trend, Memory Timeup
Parameter Selectable Range or Selections Initial Value
Memory > Save Manual or Auto Auto
Memory > Data Display, E+D, or Event Display
Memory > Event > Sample rate 1s,25,565,10s,30s,60s,120s,300s,0r600s 1s
Memory > Event > Mode Free, Trigger, or Repeat Trigger
Memory > Event > Block 1,2,4,8,0r16 1
Memory > Event > Data length 3 minutes to 31 days 1h
Memory > Event > Pre-trigger 0, 5, 25, 50, 75, 95, or 100 0
Memory > Event > Trigger > Key On/Off On
Memory > Event > Trigger > External On/Off Off
Memory > Event > Trigger > Alarm On/Off Off
Memory and trend > Meas/Math/Loop CH Meas CH, Math CH, Int CH, or Ext CH Meas CH
Memory and trend > First-CH Meas CH: 01 to 20", Math CH: 31 to 602, 01

Int CH : 101 to 106%, or Ext CH: 201 to 248
Memory and trend > Last-CH Meas CH: 01 to 20", Math CH: 31 to 602, 01

Int CH : 101 to 1068, or Ext CH: 201 to 248
Memory and trend > On/Off On/Off On
Memory timeup > Timeup type Off, Hour, Day, Week, or Month Off
Memory timeup > Date 1to0 28 1
Memory timeup > Time (hour) 0to 23 0
101 to 10 on models with 10 measurement channels.
2 Can be specified only on models with the computation function option.
3 The maximum channel number depends on the maximum number of control loops.
#3 Keylock
Parameter Selectable Range or Selections Initial Value
Keylock > Use/Not Use/Not Not
Keylock > Password Up to 6 alphanumeric characters -
Keylock > Keys such as START Free or Lock Free
Key lock > Soft keys such as ALARM ACK Free or Lock Free
Key lock > Control settings such as the input range Free or Lock Free
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List of Parameters

#4 Key login
Parameter Selectable Range or Selections Initial Value
Key login > Use/Not Use/Not Not
Key login > Auto logout On/Off Off
Key login > UserID Use/Not Use/Not Not
Key login > Number 1,2,3,4,5,6,0or7 1
Key login > On/Off On/Off On
Key login > User name Up to 16 alphanumeric characters user1
Key login > User ID Up to 4 alphanumeric characters 1
Key login > Password Up to 6 alphanumeric characters -
Key login > setup On or Off On
#5 Load, Initialize...
Parameter Selectable Range or Selections Initial Value
Load, Initialize > #1 Load settings - -
Load, Initialize > #2 Delete - -
Load, Initialize > #3 Format - -
Load, Initialize > #4 Initialize > Kind Clear1 to Clear3 Clear3
#6 Option
Parameter Selectable Range or Selections Initial Value
Remote > Action No. 1 to No. 8 None, MemoryStartStop, Trigger, AlarmACK, None

TimeAdjust, MathStartStop, MathReset,

Manual sample, Panel1Load, Panel2Load,

Panel3Load, Message1, Message2,

Message3, Message4, Message5,

Message6, Message7, Message8,

Snapshot
Timer(TLOG) > No.1 > Mode Off, Relative, or Absolute Absolute
Timer(TLOG) > No.1 > Interval 1 min, 2 min, 3 min, 4 min, 5 min, 6 min, 10 min, 12 min, 1h

15 min, 20 min, 30 min, 1 h,2h,3h,4h,6 h,8h, 12 h,

or24 h
Timer(TLOG) > No.1 > Ref.time 0:00 to 23:00 0:00
Timer(TLOG) > No.1 > Reset On/Off Off
Timer(TLOG) > No.1 > Action Off or DataSave Off
Timer(TLOG) > No.2, No.3 > Mode Off, Relative, or Absolute Off
Report > Report set Off, Hour, Day, Hour+Day, Day+Week, or Day+Month Off
Report > Date’ 11028 1
Report > Day of the week? SUN, MON, TUE, WED, THU, FRI, or SAT SUN
Report > Time(hour) 0:00 to 23:00 0:00
Report > Report CH RO1 to R30 RO1
Report > Off/On On/Off On
Report > Channel 01to 60 01
Report > Sum scale Off, /s, /min, /h, or /day /s

TWhen the report type is monthly report
2When the report type is weekly report
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List of Parameters

#7 Communication
<#1 Ethernet, Serial>

Parameter Selectable Range or Selections Initial Value
Ethernet > IP-address - 0.0.0.0
Ethernet > Subnet mask - 0.0.0.0
Ethernet > Default gateway - 0.0.0.0
Ethernet > DNS On/Off On/Off Off
Ethernet > Server search order > Primary - 0.0.0.0
Ethernet > Server search order > Secondary - 0.0.0.0
Ethernet > Host name Up to 64 alphanumeric characters -
Ethernet > Domain name Up to 64 alphanumeric characters -
Ethernet > Domain suffix search order > Primary  Up to 64 alphanumeric characters -
Ethernet > Domain suffix search order > Secondary Up to 64 alphanumeric characters -
Serial > Baud rate 1200, 2400, 4800, 9600, 19200, or 38400 bps 9600 bps
Serial > Data length 7or8 8 bit
Serial > Parity Odd, Even, and None Even
Serial > RS-232 > Handshaking Off:0ff, XON:XON, XON:RS, or CS:RS Off:Off
Serial > RS-422/485 > Address 110 32 1
Serial > RS-422/485 > Protocol Normal, Modbus, Modbus-M, or Ladder* Normal
Memory output Ethernet or serial Ethernet
" Ladder is only on models with the ladder communication option
<#2 FTP client>
Parameter Selectable Range or Selections Initial Value
FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
FTP connection Primary or Secondary Primary
FTP connection > FTP server name Up to 64 alphanumeric characters -
FTP connection > Port number 1 to 65535 21
FTP connection > Login name Up to 32 alphanumeric characters -
FTP connection > Password Up to 32 alphanumeric characters -
FTP connection > Account Up to 32 alphanumeric characters -
FTP connection > PASV mode On/Off Off
FTP connection > Initial path Up to 64 alphanumeric characters -
<#3 Control (Login, Timeout)>
Parameter Selectable Range or Selections Initial Value
Ethernet login > Use/Not Use/Not Not
Ethernet login > Level admin, user1, user2, user3, user4, user5, admin
or user6
Ethernet login > Level > On/Off On/Off On
Ethernet login > Level > User name Up to 16 alphanumeric characters admin
Ethernet login > Level > Password Up to 6 alphanumeric characters 0
Application time out > On/Off On/Off Off
Application time out > Time 110120 1 min
Keep alive > On/Off On/Off On
<#4 Modbus master>
Parameter Selectable Range or Selections Initial Value
Basic settings > Read cycle 125 ms, 250 ms, 500 ms, 1s,25s,5s,10s, 155, 2s
20s, or 30s
Basic settings > Timeout 125 ms, 250 ms, 500 ms, 1s,28,58,10s,or1min 2s
Basic settings > Retrials Off,1,2,3,4,5,10,0r 20 1
Command settings >1t0 8 On/Off Off
Command settings > 1 to 8 > Comm. Data First C01 to C30 Cco1
Command settings > 1 to 8 > Comm. Data Last C01 to C30 co1
Command settings > 1 to 8 > Address 110 247 1
Command settings > 1 to 8 > Salve Registers Input registers: 30001 to 39999, 300001 to 365535 30001
Hold registers: 40001 to 49999, 400001 to 465535
Command settings > 1 to 8 > Type INT16, UINT16, INT32_B, INT32_L, UINT32_B, INT16

UINT32_L, FLOAT_B, or FLOAT_L
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List of Parameters

<#5 AUX>
Parameter Selectable Range or Selections Initial Value
Recovery Status for Comm. Buffer > DO/SW Continue, Clear Clear
Modbus master/Ext loop > Auto recovery On/Off Off
#8 Web, E-Mail
<#1 Web>
Parameter Selectable Range or Selections Initial Value
Web > Use/Not Use/Not Not
Web > Page type Operator or Monitor Operator
Web > On/Off On/Off Off
Web > Command On/Off Off
Web > Access control On/Off Off
Web > User name Up to 16 alphanumeric characters -
Web > Password Up to 6 alphanumeric characters -
<#2 Basic E-Mail Settings>
Parameter Selectable Range or Selections Initial Value
Basic E-Mail settings > SMTP server name Up to 64 alphanumeric characters -
Basic E-Mail settings > Port number 0 to 65535 25
Basic E-Mail settings > Recipient 1 Up to 150 alphanumeric characters -
Basic E-Mail settings > Recipient 2 Up to 150 alphanumeric characters -
Basic E-Mail settings > Sender E-mail address assigned by the network
administrator (up to 64 alphanumeric characters) -
<#3 Alarm E-Mail Settings>
Parameter Selectable Range or Selections Initial Value
Alarm E-Mail settings > Recipient1 On/Off Off
Alarm E-Mail settings > Recipient2 On/Off Off
Alarm E-Mail settings > Alarm1 to 4 On/Off Off
Alarm E-Mail settings > Include INST On/Off Off
Alarm E-Mail settings > Include source URL On/Off Off

Alarm E-Mail settings > Subject
Alarm E-Mail settings > Header1
Alarm E-Mail settings > Header2

Up to 32 alphanumeric characters
Up to 64 alphanumeric characters
Up to 64 alphanumeric characters

(CX) Alarm_summary

<#4 Scheduled E-Mail Settings>

Parameter Selectable Range or Selections Initial Value
Scheduled E-Mail settings > Recipient1 On/Off Off
Scheduled E-Mail settings > Interval 1h,2h,3h,4h,6h,8h,12h,0or24 h 24 h
Scheduled E-Mail settings > Ref.time 00:00 to 23:59 00:00
Scheduled E-Mail settings > Recipient2 On/Off Off
Scheduled E-Mail settings > Interval 1h,2h,3h,4h,6h,8h,12h,0or24 h 24 h
Scheduled E-Mail settings > Ref.time 00:00 to 23:59 00:00
Scheduled E-Mail settings > Include INST On/Off Off
Scheduled E-Mail settings > Include source URL ~ On/Off Off

Scheduled E-Mail settings > Subject
Scheduled E-Mail settings > Header1
Scheduled E-Mail settings > Header2

Up to 32 alphanumeric characters
Up to 64 alphanumeric characters
Up to 64 alphanumeric characters

(CX) Periodic_data

<#5 System E-Mail Settings>

Parameter Selectable Range or Selections Initial Value
System E-Mail settings > Recipient1 On/Off Off
System E-Mail settings > Recipient2 On/Off Off
System E-Mail settings > Include source URL On/Off Off

System E-Mail settings > Subject
System E-Mail settings > Header1
System E-Mail settings > Header2

Up to 32 alphanumeric characters
Up to 64 alphanumeric characters
Up to 64 alphanumeric characters

(CX) System_warning
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List of Parameters

<#6 Report E-Mail Settings>

Parameter Selectable Range or Selections Initial Value
Report E-Mail settings > Recipient1 On/Off Off
Report E-Mail settings > Recipient2 On/Off Off
Report E-Mail settings > Include source URL On/Off Off

Report E-Mail settings > Subject
Report E-Mail settings > Header1
Report E-Mail settings > Header2

Up to 32 alphanumeric characters
Up to 64 alphanumeric characters
Up to 64 alphanumeric characters

(CX) Report_data

#9 Aux, Time zone

Parameter Selectable Range or Selections Initial Value
AUX > Tag/Channel Tag/Channel Tag
AUX > Memory alarm Off,1h,2h,5h, 10 h, 20 h, 50 h, or 100 h 1h
AUX > Language English, Japanese, German, French, or Chinese English
AUX > Partial Use/Not Not
Time zone > Difference from GMT —1200 to 1200 0
Batch Use/Not Use
#10 Control
<#1 Control action, Input setting>
Parameter Selectable Range or Selections Initial Value
Control action > PID number 1t08 8
Control action > Control period 250 ms, 500 ms, or 1 s~ 250 ms
Control action > Zone PID On/Off Off
Control action > Restart mode Continue, Manual, or Auto Continue
Control action > Restart mode (Program) Continue, Manual, or Reset Continue
Control action > Initial PID Temp or Press+Flow Temp
Control action > 6/4loop select 6 loop or 4 loop 6 loop
Control action > Auto tuning On/Off Off
Control action > Loop number 1t0 6 1
Control action > Control mode Off, Single, Cascade, PVSwitching, or Retrans Single
Control action > Control mode > Method Range, PVHigh, or Signal Range
Control action > Program control On/Off Off
Control action > PID control mode Follow-up or Fixed-point Follow-up
Input setting > Loop number 1t06 1
Input setting > Burnout > Measure1 Off, Up, or Down Up
Input setting > Burnout > Measure2 Off, Up, or Down Up
Input setting > Burnout > Remote Off, Up, or Down Up
Input setting > RJC > Measure1 External, Internal Internal
Input setting > RJC > Measure1 > Volt (uV) —20000 uV to 20000 nV 0 uv
Input setting > RJC > Measure2 External, Internal Internal
Input setting > RJC > Measure2 > Volt (uV) —20000 uV to 20000 nV 0 uv
Input setting > RJC > Remote External, Internal Internal
Input setting > RJC > Remote > Volt (uV) —20000 uV to 20000 uV ouVv
"Fixed to 1 s for A/D integral time of 100 ms.
<#2 DI/DO/SW-registration/AUX (Alarm mode...)>
Parameter Selectable Range or Selections Initial Value
Contact input > Module CTRL1-DI, CTRL2-DI, CTRL3-DI, EXT1-Rl, CTRL1-DI
CTRL1-DO, CTRL2-DO, CTRL3-DO, EXT1-RO,
INT-SW1, INT-SW2, INT-SW3
Contact input > DI001 to 006 None, AllControlStop, None

Contact input > DI101 to 106

Contact input > RI001 to 012

Contact input > DO001 to 006
Contact input > DO101 to 106
Contact input > DO201 to 206
Contact input > RO001 to 012
Contact input > SWO001 to 036

AllControlStart, ControlStart/Stop (1 to 6),
Remote/Local (1 to 6), Auto/Man (1 to 6),
Cascade (1-2 or 3-4), Auto1-2 or 3-4,

Man1-2 or 3-4, SPNumberO0 to 3 bit, ProgramRun,

ProgramReset, Hold, Advance, PatternNoO to 4bit,

PVSwitching1 to 4, MemoryStart/Stop,
Trigger, AlarmAck, TimeAdjust,
MathStart/Stop, MathReset, ManualSample,
Panel1Load to Panel3Load, Message1 to 8,
Snapshot
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List of Parameters

Parameter Selectable Range or Selections Initial Value
AUX > Loop number 1t06 1

AUX > Remote setting Off or Remote Off

AUX > Alarm mode ALWAYS, STOP, or STOP/MAN ALWAYS
AUX > SP No. selection source 1 to 6 On/Off 1: On, 2-6: Off
AUX > PV/SP math On/Off Off

AUX > CLOG error Error, Skip Error

AUX > Event output setting Common/Separate Common
<#3 Output processing>

Parameter Selectable Range or Selections Initial Value

Output processing > Loop number
Output processing > Control output

1t06
Relay, Voltage-pulse, Current-output,
or On/Off-control

1
Current-output

Output processing > Cycle time 1st0 1000 s 30s

Output processing > Analog-output type 4-20 mA, 0-20 mA, 20-4 mA, or 20-0 mA 4-20 mA

<#4 Relay>

Parameter Selectable Range or Selections Initial Value

Relay > Module CTRL1-2, CTRL3-4, CTRL5-6, or EXTDIO CTRL1-2

Relay > FAIL On/Off Off

Relay > Self diagnosis On/Off Off

Relay > DO001 to 006 De_energize/Hold, De_energize/Nonhold, Energize/Nonhold
Energize/Hold, or Energize/Nonhold

Relay > RO001 to 012 De_energize/hold, De_energize/Nonhold, Energize/Nonhold
Energize/Hold, or Energize/Nonhold

<#5 Tuning setting>

Parameter Selectable Range or Selections Initial Value

Tuning setting > Loop number
Tuning setting > 01 to 21
Tuning setting > 01 to 21 > Item ID

Tuning setting > 01 to 21 > [tem name

1t06

On/Off

SP, A1, A2, A3, A4, P |, D, OH, OL, MR,
PO, H, DR, BS1, FL1, BS2, FL2, RT, RBS,
RFL, or W01 to W36

Up to 6 alphanumeric characters

1
01-12: On, 13-21: Off
01:SP, 02: A1, 03: A2,
04: A3, 05: A4, 06: P,
07:1,08: D, 09: OH,

10: OL, 11: MR,

12: PO, 13- 21: SP
01-12: same as ltem ID,
13-21: -

<#6 External loop setting>

Parameter Value or Selections Initial Value

#1 Basic setting

Loop number Ext1 to Ext16 Ext1

Comm. Off/On On/Off Off

Modbus address 1to 247 1

Connecting model UT320, UT321, UT350, UT351, UT420, UT450, UT520, UT550, uT320
UT750, or Others

Loop select First or Second First

Tag Up to 8 alphanumeric characters EXT-01

Tag comment Up to 8 alphanumeric characters -

Auto reading Execute Execute

PV > Decimals Oto 4 0

PV > Unit Up to 6 alphanumeric characters -

SP > Decimals Oto4 0

SP > Unit Up to 6 alphanumeric characters -

OUT > Decimals Oto4 0

OUT > Unit Up to 6 alphanumeric characters %

Control span lower —30000 to 30000, span width: 30000 0

Control span upper —30000 to 30000, span width: 30000 10
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Parameter

Value or Selections

Initial Value

Control mode

Control output
Alarm

SingleLoopControl, CascadePrimaryLoop, CascadeSecondaryLoop,
CascadeControl, ControlBackup, PVSwitching, PVAutoSelector,
PVHoldFunction, DualLoopControl, Temperature-Humidity,
Cascade-2Uni, PVSwitching-2Uni, or PVAutoSelector-2Uni
Relay, Voltage-pulse, Current-output, or On/Off-control

Off, PH-H-E (PV high-limit alarm (energize)),

PV-L-E (PV low-limit alarm (energize)),

Dev-H-E (Deviation high-limit alarm (energize)),

Dev-L-E (Deviation low-limit alarm (energize)),

Dev-H-D (Deviation high-limit alarm (deenergize)),

Dev-L-D (Deviation low-limit alarm (deenergize)),

Dev-HL-E (Deviation high & low limit alarm (energize)),
D-W-HL-E (Deviation within high & low limits alarm (energize)),
PV-H-D (PV high-limit alarm (deenergize)),

PV-L-D (PV low-limit alarm (deenergize)),

PV-H-ES (PV high-limit alarm (energize/hold)),

PV-L-ES (PV low-limit alarm (energize/hold)),

Dev-H-ES (Deviation high-limit alarm (energize/hold)),
Dev-L-ES (Deviation low-limit alarm (energize/hold)),
Dev-H-DS (Deviation high-limit alarm (deenergize/hold)),
Dev-L-DS (Deviation low-limit alarm (deenergize/hold)),
Dev-HL-ES (Deviation high & low limit alarm (energize/hold)),
D-W-HL-ES (Deviation within high & low limits alarm (energize/hold)),
PV-H-DS (PV high-limit alarm (deenergize/hold)),

PV-L-DS (PV low-limit alarm (deenergize/hold)),

TimeUp1 (Timer, upward detection, hours & minutes),
TimeDown1 (Timer, downward detection, hours & minutes),
TimeUp2 (Timer, upward detection, minutes & seconds),
TimeDown2 (Timer, downward detection, minutes & seconds),
Sensor (Sensor grounding alarm),

Prog-Diag (Self diagnosis output), FAIL (FAIL output),

SP-H (SP high-limit), SP-L (SP low-limit),

Out-H (Output high-limit), Out-L (Output low-limit),

Burnout1 (Heater burnout alarm 1), or

Burnout2 (Heater burnout alarm 2),

SingleLoopControl

Relay
Off

#2 Parameter address setting
Loop number

PV: Input

SP : Setting

OUT: Output

Control mode

Remote/Local

Operation STOP/RUN

Alarm status

SP number

PID number

Auto reading

Ext1 to Ext16

30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535
30001 to 39999, 300001 to 365535,
40001 to 49999, or 400001 to 465535

Ext1
40003

40004

40005

40008

40008

40205

40011

40010

40009

40008
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Parameter Value or Selections Initial Value

#3 Tuning setting

Tuning setting > Loop number Ext1 to Ext16 Ext1

Tuning setting > 01 to 21 On/Off Off

Tuning setting > ltem ID SP, A1, A2, A3, A4, P, |, D, OH, OL, MR, H, DR, ETC
DB, PO, or ETC

Tuning setting > ltem name Up to 6 alphanumeric characters ETC

Tuning setting > Register address 30001 to 39999, 300001 to 365535, 40001
40001 to 49999, 400001 to 465535

Tuning setting > Decimal point Oto4 0

Tuning setting > Range lower —30000 to 30000, span width: 30000 0

Tuning setting > Range upper —30000 to 30000, span width: 30000 10

Setting mode (Control)

#1 Control input range

Parameter Selectable Range or Selections Initial Value

Input range > Loop number

1t06

1

Input range > Input type PV1, PV2, RemoteSP, or PVrange PVA
Input range > Mode TC, RTD, Scale, or 1-5V TC
Input range > Type DCV, TC, or RTD TC
Input range > Range TC: R/S/B/K/E/JTIN//W/L/U/PLATI/PR/WRe K

RTD: PT/JPT PT

DCV: 20mV, 60mV, 200mV, 2V, 6V, 20V, or 50V 6V
Input range > Span lower-limit Within the range of Range —200.0
Input range > Span upper-limit Within the range of Range 1370.0

Input range > PV range —30000 to 30000 Lower: 0.0, Upper: 2000.0
Input range > PV switching Lower limit —30000 to 30000 0.0
Input range > PV switching Upper limit  —30000 to 30000 2000.0

—30000 to 30000
Up to 6 alphanumeric characters -
On/Off Off

Input range > Scale
Input range > Unit

Lower: 0.00, Upper: 200.00

Input range > Square root
Input range > Low-cut 0.0% to 5.0% 1.0%
Input range > Bias On/Off Off

Selectable range when On: EUS (-100.0% to 100.0%) of 0.0%
the measurement span
Input range > Filter On/Off Off
1sto120s 1s
Input range > Ratio On/Off Off
Selectable range when On: 0.001 to 9.999 1.000
#2 Control alarm
Parameter Selectable Range or Selections Initial Value
Alarm > Loop number 1t06 1
Alarm>1to 4 On/Off Off
Alarm > Type PV-H (PV high-limit), PV-L (PV low-limit), PV-High
Dev-H (deviation high-limit), Dev-L (deviation low-limit),
Dev-H&L (deviation high & low limit),
D-W-H&L (deviation within high & low limits),
SP-H (SP high-limit), SP-L (SP low-limit),
Out-H (Output high-limit), or Out-L (Output low-limit)
Alarm > Standby On/Off Off
Alarm > Relay output On/Off Off

DOO001 to DO006, DO101 to DO106, DO201 to DO206,
ROO001 to RO012, or SW001 to SW036

1t08 1

PV high/low limits: EU (0 to 100%) of measurement span, 1370.0
SP high/low limits: EU (0 to 100%) of measurement span,

Deviation high/low limits: EUS (—100 to 100%) of measurement span,

Deviation high & low limit and

deviation within high & low limits: EUS (0 to 100%) of measurement

span, or Output high/low limit: =5.0 to 105.0%

Alarm > Number DO001, DO101, DO201

Alarm > SP number
Alarm > Alarm valuei to 4
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#3 Operation-related parameter/zone PID

Parameter Selectable Range or Selections Initial Value
Operation related/zone PID > Loop number 1t06 1
Operation related/zone PID > Suppressing function Off or Overshoot Off
Operation related/zone PID > Ramp-rate time unit Hour, Minute, or Second Hour
Operation related/zone PID > SP ramp-down-rate  On/Off Off
Selectable range when On: 1digit to EUS (100.0%)  1570.0
of the measurement span
Operation related/zone PID > SP ramp-up-rate On/Off Off
Selectable range when On: 1digit to EUS (100.0%)  1570.0
of the measurement span
Operation related/zone PID > Tag Up to 8 alphanumeric characters INT-01
Operation related/zone PID > Tag comment Up to 8 alphanumeric characters -
Operation related/zone PID > Reference point EU (0.0 to 100.0%) of the measurement span 1370.0
Operation related/zone PID > Switching hysteresis EU (0.0 to 100.0%) of the measurement span 7.8
Operation related/zone PID > Reference deviation On/Off Off
Selectable range when On: 1digit to EUS (100.0%) 7.8
of the measurement span
#4 PID parameters
Parameter Selectable Range or Selections Initial Value
PID parameters > Loop number 1t06 1
PID parameters > PID Number 1t08 1
PID parameters > Target setpoint EU (0% to 100%) of the measurement span —200.0
PID parameters > Proportional band(P) 0.1% t0 999.9% 5.0%
PID parameters > Integral time(l) 0 s to 6000 s 240 s
PID parameters > Derivative time(D) 0 s to 6000 s 60 s
PID parameters > Output lower limit —5.0% to 105.0% 0.0%
PID parameters > Output upper limit —5.0% to 105.0% 100.0%
PID parameters > Shutdown On/Off Off
PID parameters > Manual reset —5.0% to 105.0% 50.0%
PID parameters > Relay hysteresis > Value EUS (0.0 to 100.0%) of the measurement span 7.8
PID parameters > Relay hysteresis > Position Mid, High, or Low Mid
PID parameters > Reverse/Direct Reverse or Direct Reverse
PID parameters > Preset output —5.0% to 105.0% 0.0%
#5 Control group setting
Parameter Selectable Range or Selections Initial Value
Control group > Group number 1t08 1
Control group > Group name Up to 16 alphanumeric characters CONTROL GROUPH1
Control group > 1to 6 On/Off On
Control group > 1 to 6 > Kind Int-Loop, Ext-Loop, or Meas-CH Int-Loop
Control group > 1 to 6 > Number Int-Loop: 01 to 06 1: 01, 2: 02, 3: 03,
Ext-Loop: 01 to 16 4:04, 5: 05, 6: 06
Meas-CH: 01 to 20
#6 Ten-segment linearizer 1/0
Parameter Selectable Range or Selections Initial Value
Ten-segment linearizer 1/0 > Loop number 1t06 1
Ten-segment linearizer 1/0O > Input type PV1 or PV2 PV1
Ten-segment linearizer I/0 > Mode Off, Biasing, or Approximation Off
Ten-segment linearizer 1/0 > Input 1 to 11 Linearizer bias: EU (-5.0% to 105.0%) of 1:-200.0, 2: 1370.0,
the measurement span 3to 11: -200.0
Linearizer approximation: EU (—5.0% to 105.0%) of
the measurement span
Ten-segment linearizer 1/0 > Output 1 to 11 Linearizer bias: EUS (-100.0% to 100.0%) of 0.0

the measurement span
Linearizer approximation: EU (—5.0% to 105.0%) of
the measurement span
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#7 Program control related (only when program control is ON)

<#1 Program parameter setting>

Parameter Selectable Range or Selections Initial Value

#1 Pattern initial setting

Program initial setting > Pattern number 1to 4 (/PG1), 1 to 30 (/PG2) 1

Program initial setting > Segments 0to 99 0

Program initial setting > Segment setting method  Time, Ramp Time

Program initial setting > Pattern name Up to 16 alphanumeric characters Pattern 1

Program initial setting > Action loop > Loop 1to 6 On/Off Off

#2 Wait action setting

Wait action setting > Wait zone 1t0 5> Loop1to6  On/Off Off

> High, Low EUS (100.0%) of the measurement span 1 digit

Wait action setting > Wait time 00:00:00 to 99:59:59 00:00:00

#3 Pattern start setting

Pattern start setting > Start target setpoint > Loop 1to 6 EU (0% to 100%) of the measurement span —200.0

Pattern start setting > Start code StartTargetSP, RampPV1 to RampPV6, TimePV, StartTargetSP

#4 Program pattern setting

Program pattern setting > Segment number 1 to specified number of segments 1

Program pattern setting > Ramp/Soak select Ramp, Soak Ramp

Program pattern setting > Target setpoint > Loop 1to 6 EU (0% to 100%) of the measurement span —200.0

Program pattern setting > Segment time' 00:00:00 to 99:59:59 00:00:01

Program pattern setting > Ramp-rate time unit? Hour, Minute Hour

Program pattern setting > Ramp? 1 digit to EUS (100.0%) of the measurement span 1 digit

Program pattern setting > Segment PID group No. 1 to specified PID number 1

Program pattern setting > Segment shift action Continue, HoldShift, LocalShift, ResetShift Continue

Program pattern setting > Wait action Off, Shift, Within Off

Program pattern setting > Wait zone number 1t05 1

#5 Event setting

Event setting > Segment number 1 to specified number of segments 1

Event setting > Event kind PVEvent, TimeEvent TimeEvent

Event setting > TimeEvent 1 to 16 On1, On2, On3, Off Off

Event setting > TimeEvent 1 to 16 > On-time, Offtime  00:00:00 to 99:59:59 00:00:00

Event setting > PVEvent 1 to 16 > Loop Off, 1t0 6 Off

Event setting > PVEvent 1 to 16 > Loop > Type PV-High, PV-Low, Deviation-High, Deviation-Low, Deviation-H&L, PV-High
Dev-within-H6L, SP-High, SP-Low, Output-High, Output-Low

Event setting > PVEvent 1 to 16 > Loop > Value PV: EU (0% to 100%) of the measurement span 1370.0
Deviation: EUS (0% to 100%) of the measurement span 1570.0
SP: EU (0% to 100%) of the measurement span 1370.0
Output: -5.0 % to 105.0 % 105.0 %

#6 Hysteresis (PV event)

Hysteresis (PV event) > PV event > Hysteresis 1to 16  0.0% to 10.0 0.5%

#7 Repeat action setting

Repeat action setting > Repeat action Off, On, Repeat Off

Repeat action setting > On > Repeat frequency 1to 999 1

Repeat action setting > Repeat action 1 to specified number of segments 1

> Repeat start segment

Repeat action setting > Repeat action 1 to specified number of segments 1

> Repeat end segment

"When [Time] is specified for the segment setting method.

2When [Ramp] is specified for the segment setting method.

<#2 Event output setting*>

Parameter Selectable Range or Selections Initial Value

Event output > Pattern number 1to 4 (/PG1), 1o 30 (/PG2) 1

Event output > Event kind PVEvent, TimeEvent TimeEvent

Event output > Relay Output EV1 to 16 On, Off Off

Event output > On EV1 to 16 > Number DO001 to DO006, DO101 to DO106, DO201 to DO2086, DOO001
RO001 to RO012, SW001 to SW036

Program pattern end signal > Relay Output On, Off Off

Program pattern end signal > On > Number DO001 to DO006, DO101 to DO106, DO201 to DO2086, DOO001

ROO001 to RO012, SW001 to SW036

* With version 3.01, event output setting is included as item #6 within #1 Program pattern setting.
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<#3 AUX (Auto message, Display position)>

Parameter Selectable Range or Selections Initial Value
AUX (Auto message, Display position) > On, Off On

Auto message for program Run/Reset On/Off

AUX (Auto message, Display position) > 1t06 Loop 1t0 6:1t0 6
Program display position > Position > Loop 1 to 6

AUX (Auto message, Display positin) > On, Off Off

Auto change to program run display

<#4 AUX (Event group)>

Parameter Selectable Range or Selections Initial Value
AUX (Event group) > Pattern number 1to 4 (/PG1) or 1to 30 (/PG2) 1

AUX (Event group) > 110 5 On, Off On

AUX (Event group) > On 1 to 5 > Kind PVEvent, TimeEvent Time Event
AUX (Event group) > Number 0110 05 11t05:01to 05

#8 Detailed settings (#7 when the program control function is OFF)

<#1 Control function>

Parameter Selectable Range or Selections Initial Value
Control function > Loop number 1t06 1
Control function > SP Tracking Off/On On
Control function > PV tracking On/Off Off
Control function > Target setpoint limiter > Lower EU (0.0% to 100.0%) of the measurement span —200.0
Control function > Target setpoint limiter > Upper  EU (0.0% to 100.0%) of the measurement span 1370.0
Control function > Output velocity limiter On/Off Off
Enter the value for On: 0.1%/s to 100.0%/s 100.0%/s
Control function > Anti-reset windup Auto or Manual Auto
Enter the value for Manual: 50.0% to 200.0% 100.0%
<#2 Hysteresis (Alarm)>
Parameter Selectable Range or Selections Initial Value
Hysteresis (Alarm, PV event) > Alarm > Loop number 1 t0 6 1
Hysteresis (Alarm, PV event) > Alarm > Hysteresis1 to 4 EUS (0.0% to 10.0%) of the measurement span 7.8
<#3 DIO monitor and operation setting>
Parameter Selectable Range or Selections Initial Value
DIO monitor and operation setting > 01 to 36 01
DIO entry number
DIO monitor and operation setting > On/Off On, Off Off
DIO monitor and operation setting > Kind DI-1, DO-1, DO-2, DIO-11, DIO12, DO-2P, DI-1
DIO-12P
DIO monitor and operation setting > SW number  SWO001 to SW036 SWO001
DIO monitor and operation setting > DO number > DOO001 to DO006, DO101 to DO1086, DOO001
ON DO201 to DO206, RO001 to RO012,
DIO monitor and operation setting > DO number > DOO001 to DO006, DO101 to DO1086, DOO001
OFF DO201 to DO206, RO001 to RO012,
DIO monitor and operation setting > DI number DI001 to DI006, DI101 to DI106, DI001

DIO monitor and operation setting > Tag

DIO monitor and operation setting > Tag comment

DIO monitor and operation setting >
Operation property >ON > Label
DIO monitor and operation setting >
Operation property >ON > Color

DIO monitor and operation setting >
Operation property >OFF > Label
DIO monitor and operation setting >
Operation property >OFF > Color

DI201 to DI206, RI001 to RI012,
Up to 8 alphanumeric characters
Up to 8 alphanumeric characters
Up to 8 alphanumeric characters

Red, green, blue, blue violet, brown, orange, yellow-green, Red

light blue, violet, gray, lime, cyan, dark blue, yellow,

light gray, or purple
Up to 8 alphanumeric characters

Red, green, blue, blue violet, brown, orange, yellow-green, Red

light blue, violet, gray, lime, cyan, dark blue, yellow,

light gray, or purple
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<#4 DI/DO label setting>

Parameter

Selectable Range or Selections

Initial Value

DI/DO label setting > Module

DI/DO label setting > DI001 to DI006 > Label
DI/DO label setting > DI101 to DI106 > Label
DI/DO label setting > DI201 to DI206 > Label
DI/DO label setting > RI001 to RI006 > Label
DI/DO label setting > DO001 to DO006 > Label
DI/DO label setting > DO101 to DO106 > Label
DI/DO label setting > DO201 to DO206 > Label
DI/DO label setting > RO001 to RO006 > Label

CTRL1-DI, CTRL2-DI, CTRL3-DI, EXT1-Rl,
CTRL1-DO, CTRL2-DO, CTRL3-DO, EXT1-RO

Up to 16 alphanumeric characters
Up to 16 alphanumeric characters
Up to 16 alphanumeric characters
Up to 16 alphanumeric characters
Up to 16 alphanumeric characters
Up to 16 alphanumeric characters
Up to 16 alphanumeric characters
Up to 16 alphanumeric characters

CTRL1-DI

DI001 to DI006
DI101 to DI106
DI201 to DI206
RI1001 to RI006
DO001 to DO006
DO101 to DO106
DO201 to DO206
RO001 to RO006

#9 Detailed settings (#8 when the program control function is OFF)

<#1 PV/SP math, Retransmission>

Parameter

Selectable Range or Selections

Initial Value

PV/SP math, Retransmissin > Loop number
PV/SP math, Retransmissin > PV/SP

PV/SP math, Retransmissin > Mode
PV/SP math, Retransmissin >

Calculation expression

PV/SP math, Retransmissin > PV range >
Lower-limit

PV/SP math, Retransmissin > PV range >
Upper-limit

PV/SP math, Retransmissin > Unit

PV/SP math, Retransmissin > PV swithing > Lower
PV/SP math, Retransmissin > PV swithing > Upper
PV/SP math, Retransmissin > Math error

1t06

PV, PV1, PV2, SP

(Depending on the control mode)
On/Off

Up to 120 alphanumeric characters

-30000 to 30000 (upper-lower < 30000)

-30000 to 30000 (upper-lower < 30000)

Up to 6 alphanumeric characters
-30000 to 30000 (upper-lower < 30000)
-30000 to 30000 (upper-lower < 30000)
Over, Under

1
Value depending on the
control mode

Off

Previously determined
control input channel No.
Measurement range

of calcuration expression
initial viue

Measurement range

of calcuration expression
initial viue

Lower limit of PV range
Upper limit of PV range
Over

<#2 Logic math>

Parameter Selectable Range or Selections Initial Value
Logic math > Setting number 1-6, 7-12, 13-18, 19-24, 25-30 1-6
Logic math > Relay Off, DO001 to DO006, DO101 to DO106, Off
DO201 to DO206, Ro001 to RO012,
SW001 to SW036
Logic math > Calculation expression Up to 120 alphanumeric characters -
<#3 Constant>
Parameter Selectable Range or Selections Initial Value

Constant > W01 to W36

—9.9999E+29 to —1.0000E-30, 0,
1.0000E-30 to 9.9999E+29

1
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Set mode
#1 Range, Alarm
Parameter Selectable Range or Selections Initial Value
First-CH 01 to 20 01
Last-CH 01 to 20 01
Range > Mode Volt, TC, RTD, Scale, Delta, DI, Sqrt, or Skip Volt
Range > Range 20mV, 60 mV,200mV,2V,6V,20V, 50V, 2V
R,S,B, K, E, J, T,N, W, L, U, PLATI, PR, Wre,
PT, JPT, Level, or Cont
Range > Span Lower - —2.000
Range > Span Upper - 2.000
Alarm >1to 4 On/Off Off
Alarm > Type H: High limit, L: Low limit, R: Rate-of-change, H
T: Delay high, t: Delay low
Alarm > Value - 0.000
Alarm > Relay On/off On/Off Off
Alarm > Relay Number 101 to 106, DO001 to DO006, DO101 to DO106, 101
DO201 to DO206, RO001 to RO012, or
SWO001 to SW036
Alarm > Detect On/Off On
#2 Tag, Moving average, Alarm delay
Parameter Selectable Range or Selections Initial Value
First-CH 01 to 20, 101 to 118, or 201 to 248 01
Last-CH 01 to 20, 101 to 118, 201 to 248 01
Tag Up to 16 alphanumeric characters 01

Moving average > Count

Off, 2,3,4,5,6,7,8,9,10, 11, 12,13, 14, 15, or 16  Off

Alarm delay > Time 1st0 3600 s 10s

#3 Trend/Save interval, Message, File, User key, DST

Parameter Selectable Range or Selections Initial Value

Trend/Save interval > Time/div 1 min, 2 min, 5 min, 10 min, 20 min, 30 min, 1 h, 1 min
2h,4h,0or10h

Trend/Save interval > Auto save interval 10 minutes to 31 days 1h

Message > Characters No. 1 to No. 8 Up to 16 alphanumeric characters -

File > Header Up to 32 alphanumeric characters -

File > Directory name Up to 8 alphanumeric characters DATAO

File > Save data Unsave or All All

USER key > Action None, Trigger, AlarmACK, MathStart/Stop, AlarmACK
MathReset, ManualSample, Message1 - Message8,
or Snapshot

Daylight saving time (YY/MM/DD HH) > Summer  Off/On Off

Daylight saving time (YY/MM/DD HH) > Winter Off/On Off

#4 Display

<#1 Group set, Trip line>

Parameter Selectable Range or Selections Initial Value

Group number 1t0 10 1

Group set > Group name Up to 16 alphanumeric characters GROUP 1

Group set > CH set - 01-10

Group set>Tripline>No. 1toNo.4  On/Off Off

Group set > Trip line > Position 0% to 100% 100%

Group set > Trip line > Color Red, green, blue, blue violet, brown, orange, yellow-green, light blue,

violet, gray, lime, cyan, dark blue, yellow,light gray, or purple

No.1: Red, No.2: Green,
No.3: Blue, No.4: Yellow
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<#2 Color>
Parameter Selectable Range or Selections Initial Value
Color > CH1, CH11 Red, green, blue, blue violet, brown, orange, yellow-green, light blue, Red
violet, gray, lime, cyan, dark blue, yellow, light gray, or purple
Color > CH2, CH12 Same as above Green
Color > CH3, CH13 Same as above Blue
Color > CH4, CH14 Same as above Blue-violet
Color > CH5, CH15 Same as above Brown
Color > CH6, CH16 Same as above Orange
Color > CH7, CH17 Same as above Yellow-green
Color > CH8, CH18 Same as above Light blue
Color > CH9, CH19 Same as above Violet
Color > CH10, CH20 Same as above Gray
<#3 Zone, Graph, Partial>
Parameter Selectable Range or Selections Initial Value
First-CH 01to 20 01
Last-CH 01 to 20 01
Zone > Lower 0% to 95% 0%
Zone > Upper 5% to 100% 100%
Graph > Division 4,5,6,7,8,9,10, 11,12, or C10 10
Graph > Bar graph Normal or Center Normal
Graph > Scale position Offor 1to 10 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span value — 1 digit or minimum 0.000
scale value + 1 digit to maximum scale value — 1 digit (when the channel is set
to scaling or square root computation)
<#4 View, Direction, LCD>
Parameter Selectable Range or Selections Initial Value
View > Direction > Trend Horizontal, Vertical, or Horizon2 Horizontal
View > Direction > Bar graph Horizontal or Vertical Vertical
View > Background > Measure White or Black White
View > Background > Control White or Black Black
View > Trend line 1, 2, or 3 dots 2 dots
View > Trip line 1, 2, or 3 dots 2 dots
View > Grid Auto, 4 div, 5 div, 6 div, 7 div, 8 div, 9 div, 10 div, 10 div
11 div, or 12 div
View > Scroll 5s,10s,20s,30s, 1 min 5s
View > Scale digit Normal or Fine Normal
LCD > Brightness 1t0 4 3
LCD > Backlight saver > On/Off On/Off Off
LCD > Backlight saver > Saver time 1 min, 2 min, 5 min, 10 min, 30 min, or 1 h 1h
LCD > Restore Key or Key+Alm Key+Alm
<#5 Control (Color)>
Parameter Selectable Range or Selections Initial Value
Select Internal, Ext1, Ext2, or Ext3 Internal
CH101, CH110, CH201...CH237...CH246 Red, green, blue, blue violet, brown, orange, Red
yellow-green, light blue, violet, gray,
lime, cyan, dark blue, yellow, light gray, or purple
CH102, CH111, CH202...CH238...CH247 Same as above Green
CH1083, CH112, CH203...CH239...CH248 Same as above Blue
CH104, CH113, CH204...CH240 Same as above Blue-violet
CH105, CH114, CH205...CH241 Same as above Brown
CH106, CH115, CH206...CH242 Same as above Orange
CH107, CH116, CH207...CH243 Same as above Yellow-green
CH108, CH117, CH208...CH244 Same as above Light blue
CH109, CH118, CH209...CH245 Same as above Violet
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<#6 Control (Zone, Graph (, Partial))>

Parameter Selectable Range or Selections Initial Value
First-CH 101 to 118 or 201 to 248 101
Last-CH 101 to 118 or 201 to 248 101
Zone Lower 0% to 95% 0%
Zone Upper 5% to 100% 100%
Division 4,5,6,7,8,9,10, 11,12, 0r C10 10

Bar graph Normal or Center Normal
Scale position Off or 1t0 10 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span value — 1 digit or minimum 0.1

scale value + 1 digit to maximum scale value — 1 digit (when the channel is set
to scaling or square root computation)

<#7 Math (Color)>

Parameter Selectable Range or Selections Initial Value

CH31, CH41, CH51 Red, green, blue, blue violet, brown, orange, Red
yellow-green, light blue, violet, gray,
lime, cyan, dark blue, yellow, light gray, or purple

CH32, CH42, CH52 Same as above Green
CH383, CH43, CH53 Same as above Blue

CH34, CH44, CH54 Same as above Blue-violet
CHB35, CH45, CH55 Same as above Brown
CH36, CH46, CH56 Same as above Orange
CH37, CH47, CH57 Same as above Yellow-green
CH38, CH48, CH58 Same as above Light blue
CH39, CH49, CH59 Same as above Violet

CH40, CH50, CH60 Same as above Gray

<#8 Math (Zone, Graph (, Partial))>

Parameter Selectable Range or Selections Initial Value
First-CH 31 to 60 31
Last-CH 31 to 60 31
Zone > Lower 0% to 95% 0%
Zone > Upper 5% to 100% 100%
Graph > Division 4,5,6,7,8,9,10, 11,12, 0r C10 10
Graph > Bar graph Normal or Center Normal
Graph > Scale position Off or 1to 10 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span value — 1 digit or minimum 0.00

scale value + 1 digit to maximum scale value — 1 digit (when the channel is set
to scaling or square root computation)

#5 Save/Load, Clear data

Parameter Selectable Range or Selections Initial Value

#1 Save settings - _
#2 Load settings - -
#3 Save data - —
#4 Load display data - -
#5 Load event data - -
#6 File list - _
#7 Delete - -
#8 Format — _
#9 Clear data - -
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#6 Time
Parameter Selectable Range or Selections Initial Value
Time set > YY/MM/DD HH/MM/SS - -
#7 Math set1 (expression, alarm, constant)
Parameter Selectable Range or Selections Initial Value
First-CH 31 to 60 31
Last-CH 3110 60 31
Math range > Math On/Off On/Off Off
Math range > Calculation expression 40 characters or less. 01
Math range > Span Lower —9999999 to 99999999 (decimal point: within 4 digits to —200.00
the right of the decimal point)
Math range > Span Upper —9999999 to 99999999 (decimal point: within 4 digits to 200.00
the right of the decimal point)
Math range > Unit Up to 6 alphanumeric characters -
Alarm>1to 4 On/Off Off
Alarm > Type H L T ort H
Alarm > Value Value within the measurement span 0.00
Alarm > Relay On/Off On/Off Off
Alarm > Relay Number 101 to 106, DO001 to DO006, DO101 to DO106, 101
DO201 to DO206, RO001 to RO012, or SW001 to SW036
Alarm > Detect On/Off On
Constant > K01 to K30 —9.9999E+29 to —1.0000E-30, O, 1
1.0000E-30 to 9.9999E+29
#8 Math set2 (tag, TLOG, rolling average, alarm delay)
Parameter Selectable Range or Selections Initial Value
First-CH 31 to 60 31
Last-CH 31 to 60 31
Tag>Tag Up to 16 alphanumeric characters 31
TLOG > Timer No. 1,2,0r3 1
TLOG > Sum scale Off, /s, /min, or /h Off
Rolling average > On/Off On/Off Off
Rolling average > Interval 1s,2s,3s,4s,5s,6s, 10s, 12s, 15s, 20s, 30s, 10s
1 min, 2 min, 3 min, 4 min, 5 min, 6 min, 10 min, 12 min,
15 min, 20 min, 30 min, or 1 h
Rolling average > Number of samples 1to 64 1
Alarm delay 1sto 3600 s 10s
#9 Batch set
Parameter Selectable Range or Selections Initial Value
Application name Up to 16 alphanumeric characters -
Supervisor name Up to 16 alphanumeric characters -
Manager name Up to 16 alphanumeric characters -
Batch number Up to 16 alphanumeric characters -
Lot number Up to 4 alphanumeric characters -
Auto increment On/Off On
Disp information Batch, Time Batch
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